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Preface

This preface provides information about the objectives, organization, and conventions used in the User 
Guide.

Objectives of this Book
This guide explains how to install, configure, administer, and maintain the Connect client.

Organization
This guide includes the following sections:

Table 1:  User Guide Contents

Chapter Description

Chapter 1, Installing the Connect Client Describes the requirements and procedures to 
install and launch the Connect client on Windows 
and Macintosh.

Chapter 2, Using the Connect Client Describes the procedure to sign in and navigate 
through Connect client.

Chapter 3, Managing Contacts Describes the procedures to:

 Add and delete a contact
 Create, edit, and delete a contact group

Chapter 4, Managing Availability States Describes the availability icons and the process 
to change the availability status.

Chapter 5, Managing Phones Describes the procedures to assign a desk 
phone, softphone, and external number to the 
Connect client.

Chapter 6, Managing Calls Describes the procedures to manage and route 
calls and voicemails.
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Preface Conventions

Conventions
This guide uses the following advisory notices: 

The following typographical marking conventions are used in this document.

Chapter 7, Managing Messages Describes the procedures to:

 Send a Message and group voicemail
 Manage Message Notifications

Chapter 8, Integrating with Microsoft Exchange/
Office 365

Describes the procedure to:

 Integrate Connect client and voicemail with 
Microsoft Exchange

 Integrate Outlook contacts and calendar with 
Connect client

Chapter 9, Managing Conferences Describes the procedures to:

 Create, view, record, and cancel conferences.
 Join a Connect conference from any non-Mitel 

network without entering any authentication 
details.

Chapter 10, Sharing Screen Describes the procedure to share screens.

Chapter 11, Managing Emergency Location 
Information

Describes the procedures to:

 Add the emergency location information
 Manage the emergency location information

Appendix A, Operator Features Describes the features available only for 
Operators.

Note
This information is extra, or supplementary.

Marking Meaning

Bold Names of interface objects, such as buttons and menus. 

Blue Cross references with hyper-links. Click the blue text to go to the indicated 
section. 

Note: Table of Contents entries are also links, but they are not shown in blue. 

Table 1:  User Guide Contents

Chapter Description
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1. Installing the Connect Client

This chapter provides information about how to install the Connect client.

Overview .....................................................................................................................  8
Anti-Virus Folders Exclusions .....................................................................................  9
Installing the Connect Client on Windows OS...........................................................  10
Installing the Connect Client on macOS ...................................................................  11
Upgrading Connect Client .........................................................................................  12
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Installing the Connect Client Overview1

Overview
The Connect presents a single interface to manage business communications using a desk phone, 
computer, or mobile phone. With support for Microsoft Windows, macOS, and Collaboration for Web, 
the Connect client simplifies your day-to-day communications and streamlines your work. 

Operating System
For Microsoft Windows:

 Microsoft Windows 8.1 
 Microsoft Windows 10 
 Microsoft Windows 11 (64 bit)

For macOS:

 macOS Catalina 10.15.7
 macOS Big Sur 11.6.1
 macOS Monterey 12.0.1

For Windows Server:

 Windows Server 2016, 64-bit (Standard)
 Windows Server 2012, 64-bit (Standard)
 Windows Server 2008 SP2 (Standard)

Minimum Hardware Configuration
For Windows:

 Processor (Windows 10): Intel Core™ i3-8100T or 8th Generation Intel® Core™ i3-8145U
 Hard Disk Space: 4GB
 RAM Total: 8GB
 RAM Available: 500 MB (1GB preferred)

For macOS:

 Processor: 3.6GHz quad-core Intel Core i3 or 1.4GHz quad-core Intel Core i5
 Hard Disk Space: 4GB
 RAM Total: 8GB
 RAM Available: 500 MB (1GB preferred)

Supported Servers
 Microsoft Exchange 2013
 Microsoft Exchange 2016
 Microsoft Office 365
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Supported Outlook Versions
 Outlook 2016 (Windows only)
 Outlook 2013 (Windows only) 
 Outlook Office 365

Supported Browsers
For Microsoft Windows:

 Chrome 96.0.4664.110
 Firefox 95.0.2
 Edge 96.0.1054.62

For macOS:

 Chrome 96.0.4664.110
 Edge 96.0.1054.62
 Firefox 95.0.2
 Safari 15.1,15.2

Supported Environments
 Citrix XenDesktop 7.6 LTSR
 Citrix XenApp 7.6 LTSR
 Citrix XenDesktop 7.15 LTSR
 Citrix XenApp 7.15 LTSR

Anti-Virus Folders Exclusions
On your computer, you must exclude the below folders and sub-folders from the Virus Checker 
software before installing the Connect Client.

Connect Client

<Drive>:\Users\%User%\AppData\Local\Mitel
<Drive>:\Users\%User%\AppData\Roaming\Mitel
<Drive>:\Program Files (x86)\Mitel
<Drive>:\Program Files (x86)\Mitel Presenter

Note

 Softphone is not supported in the Citrix environment.

 The US cloud users installing the Connect Client application in the Citrix environment also need to 
publish the Teamwork for desktop along with the Connect Client application to use the cross-launch 
functionality for individual Direct and Group messages.
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Installing the Connect Client Installing the Connect Client on Windows OS1

Installing the Connect Client on Windows OS

1. Open the e-mail notification from your Connect administrator that describes how to install the 
Connect client, and click the link to install the client.

2. On the License Agreement page, select I accept the terms in the license agreement, and click 
Next.

3. Click Next to install the client in the default folder, or click Change to change the destination folder 
and continue.

4. On the Ready to Install the Program page, click Install.

5. On the InstallShield Wizard page, click Finish.

6. On the Start menu, click the Connect icon to launch the client.

Note
If you have installed the ST Communicator on your computer, the Connect client installer will uninstall 
the Communicator before installing the Connect client.

Note
The Teamwork for Desktop application is packaged with the Connect client application, which enables 
MiCloud Connect users to use Teamwork for Desktop application for messaging. 

 The Teamwork for Desktop application gets automatically installed when the user installs the 
Connect client application.

 The Connect client application continues to function normally after the Teamwork for Desktop 
application is uninstalled. However, the Connect Client users are not able to perform any 
messaging operation. To get back the message functionality, the user must uninstall and re-install 
the Connect client application.
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Installing the Connect Client on macOS
1. Open the e-mail notification from your Connect administrator that describes how to install the 

Connect client, and click the link to install the client.
The installation file is downloaded to the default downloads folder on your computer.

2. Double-click the installation file.

3. In the Connect screen, drag the Connect icon into the Applications folder and double-click the 
icon to launch the client.

Note
The Teamwork for Desktop application is packaged with the Connect Client application, which enables 
MiCloud Connect users to use Teamwork for Desktop application for messaging.

After installing Connect Client application, when the user logs in to Connect Client for the first time, the 
system automatically installs the Teamwork for Desktop application and logs in the user.
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Installing the Connect Client Upgrading Connect Client1

Upgrading Connect Client
When a newer version of Connect client is available, you see two kinds of upgrade notifications after 
you sign in. For more information on signing into Connect Client, refer to Chapter 2, Using the Connect 
Client on page 14.

 Recommended Upgrade- You can either install or skip the recommended update. However, in 
order to have the latest fixes and features, Mitel recommends you to upgrade your Connect Client 
to the latest version. Especially if the Connect client is two or more versions behind the current 
version.

Click Upgrade in the upgrade notification area to get the latest version of Connect client, or click 
Later to upgrade at a later time.

 Required Upgrade—You cannot access the application without upgrading. You must upgrade the 
application or exit if you choose not to upgrade.

Click Upgrade in the upgrade notification to get the latest version of Connect client, or click Exit.

Tip
(For windows users only)

A non-admin version of the installer is available which does not require administrator rights to install 
the Connect client.

This enables users to install the upgrades at their pace without requiring a Group Policy Object (GPO).

To install the non-admin version of the Connect client:

1. As a one time activity, ask your administrator to uninstall the current version of the Connect client, 
the Teamwork, and the Mitel presenter. 
It is recommended to reboot your system after the uninstall is complete.

2. Open the e-mail notification from your Connect administrator that describes how to install the non-
admin version of the Connect client and a link to the installer.

Notes: 

 In the Microsoft Outlook, in the pop-up, click Install to install the UCB add-in. 

 In the Microsoft Outlook 2016 and Office 365, the telephony and the IM icons are disabled under 
Outlook contact card.

After installing the non-admin version of the Connect client, any client upgrades going forward will not 
require administrator rights.

Note: 

 Do not choose “C:\Program Files (x86)” or “C:\Program Files” location for installing the Connect 
client. The non-admin installer does not have the permissions to overwrite the files in these folders. 
(Do not change the installation location.)

 Admin version and non-admin version of the client cannot be installed on the same machine.

 On a single machine, each user has to install a different instance of the Connect client.
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If the upgrade fails, you receive an error notification. Click Exit in the error notification area to exit.

Feature Comparison Between Admin Installer and Non-Admin 
Installer

Features Admin Installer Non-Admin Installer

Installation/Upgrade 
permission 

Admin privilege is required to 
install or upgrade. 

Admin privilege is not required to install 
or upgrade. 

Terminal Server/VDI 
Environment support 

Supported on Terminal Server/
VDI environments. 

Not supported on Terminal server/VDI 
environments. 

GPO push GPO Push to be done at the 
System level. 

GPO Push to be done at the user level. 

Supported upgrade 
version 

Upgrade is supported from any 
admin version lower than 
213.100.5057. 

Upgrade is not supported from admin 
version lower than 213.100.5057. 
Uninstall the existing Connect Client, 
Teamwork Desktop and Mitel Presenter 
using admin privilege, before installing 
non-admin client. 

Outlook contact card Message and call feature is 
supported in Outlook 2016 
contact card. 

Message and call feature is disabled in 
Outlook 2016 contact card. 

Installation/Access level Admin client is installed at system 
level, so other users of same 
machine can see/access connect 
client. 

Non-admin client is installed at user 
level, so other users of same machine 
cannot see/access connect client. Each 
user of the machine needs to install 
Connect client separately. 

UCB add-in UCB Add-in is included as part of 
the installer package. 

An Outlook add-in installation pop-up 
will ask user’s permission. 
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2. Using the Connect Client

This chapter provides information about how to use the Connect client.

Signing in to the Connect Client................................................................................  15
Signing in from the Mitel Authentication Portal ...................................................  15
Signing in from the Connect Client Login Interface ............................................  16
Signing in to Teamwork Automatically ................................................................  16
Opening the Connect Client Automatically .........................................................  16
Changing the Password .....................................................................................  17

Navigating through the Connect Client Interface ......................................................  17
Pinning Tabs for Quick Access ...........................................................................  21
Connect Client Location .....................................................................................  22

Selecting Preferred Language ..................................................................................  22
Selecting Preferred Language ..................................................................................  22
Setting a Sound Notification......................................................................................  24
Connect Client Logs..................................................................................................  23

Connect Collaboration web client logs from iOS device .....................................  23
Sharing Data with Mitel .............................................................................................  25



Signing in to the Connect Client Using the Connect Client 2

Connect Client User Guide 15

Signing in to the Connect Client
You sign in to the Connect client from either the Mitel Authentication Portal or the Connect client login 
interface depending on your Mitel phone system and geographic location. 

Signing in from the Mitel Authentication Portal
If you use a MiCloud Connect phone system, use the following instructions to sign in to the Connect 
client from the Mitel Authentication Portal. For more detailed instructions, see the Mitel Unified Sign In 
article. 

1. Open the Connect client. 

2. When the “Sign in to Mitel” screen appears, enter your Mitel username, which usually defaults to 
your business email address.

If your username is associated with more than one Mitel account, a “Multiple accounts located” 
message is displayed. If this occurs, select the desired Mitel system from the drop-down menu or 
enter the Account Number/Partner Label for your Mitel account. For some customers, this 
message appears when you enter your password.

3. Click Next.

4. In the next “Sign in to Mitel” screen that appears: 

 If your account utilizes Mitel authentication, enter your Mitel password and click Next.

 If your account utilizes Microsoft Active Directory authentication, use the following steps:

 Click the Single Sign On button.
 When the Microsoft “Enter password” screen appears, enter your enterprise password and 

click Sign in.
 If the “Enter code” screen appears (multi-factor authentication is enabled), locate the code 

provided to you via the security method configured in Active Directory (text message, app 
message, phone call), enter the code in the Code field, and click Verify.

To sign out from Connect client, click the drop-down below the <username> on the dashboard, and 
click Logout.

Notes 

 For users in Australia region: This procedure is applicable for users who are using Connect 
Client version 213.100.4870 or later. 

 For users in UK region: This procedure is applicable for users who are using Connect Client or 
version 213.100.5057.0 later.

Other users in Australia and UK region must follow the instructions in Signing in from the Connect 
Client Login Interface.

https://oneview.mitel.com/s/article/Mitel-Unified-Sign-In
https://oneview.mitel.com/s/article/Mitel-Unified-Sign-In
https://oneview.mitel.com/s/article/Mitel-Unified-Sign-In
https://oneview.mitel.com/s/article/Mitel-Unified-Sign-In
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Using the Connect Client Signing in from the Connect Client Login Interface2

Signing in from the Connect Client Login Interface
1. Open the Connect client. 

2. Enter your Mitel username, which usually defaults to your business email address.

If your Connect client and Microsoft Exchange email addresses are the same, sign in using your 
email address to integrate the Connect client with Microsoft Exchange. For more information, refer 
to Chapter 8, Integrating with Microsoft Exchange/Office 365 on page 88.

3. Enter your Mitel password.

4. To save your credentials, select the Remember me check box.

This option remembers the password only if you exit the application, and not log out. If you log out, 
you must re-enter the password to sign in.

5. Click the Login button to sign into the Connect client.

To sign out from Connect client, click the drop-down below the <username> on the dashboard, and 
click Logout.

Depending on how your system is configured, you might need to enter your credentials manually 
rather than using the Use Windows Credentials check box.

Signing in to Teamwork Automatically
The Teamwork for Desktop application is packaged with the Connect client application. This allows 
MiCloud Connect users to use this application for messaging. Note the following:

 When signing in to the Connect client application, you are automatically signed in to the Teamwork 
for Desktop application.

 Logging out of the Connect client does not log you out from Teamwork for Desktop, which can be 
used independently of the Connect client. This means you can log out of the Connect client and 
continue using Teamwork for Desktop.

 If you log out of Teamwork for Desktop, the Connect client continues to function normally, but 
messaging functionality is disabled. To restore messaging functionality, log out of the Connect 
client and then log back in to the Connect client, which automatically signs in to and opens 
Teamwork for Desktop.

Opening the Connect Client Automatically
You can enable Connect client to open automatically when you start the computer. 

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings, and then click Accounts.

3. On the second pane, click Login.
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4. Select Automatically launch Mitel Connect when starting the computer.

Changing the Password

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Accounts.

3. On the second pane, click Login.

4. To change your password, if you sign in to the Connect client:

 From the Connect client login interface, enter the following in the Account > Login screen and 
click the Set New Password button:

 Current password
 New password
 Confirm new password

Navigating through the Connect Client Interface
The Connect client consists of three panes based on the options you select on the dashboard, as 
shown in Figure 1.

Note
If your password is expired, the password expiry notification appears when you sign in. To change the 
expired password, enter the new password in New password and Retype password fields, then click 
Save & Login.

Note
From the Mitel authentication portal, click the Change New Password button, enter the following in 
the Mitel Change Password screen that appears, and click Next:

 Current password

 New password

 Confirm new password
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Using the Connect Client Navigating through the Connect Client Interface2

Figure 1:  Connect Client 

 Connect menu bar—Use the Connect drop-down on the client menu bar to do the following:

 View information about the Connect (Version, Copyright, Privacy Policy and End-User License 
Agreement).

 Check for updates.

 Open the Settings page (for Windows) or Preferences page (for macOS).

 Set the Connect client to be on top while navigating through other applications. For macOS, 
this option is available in the Window tab on the Mac menu bar.

 Navigate to the Mitel support page. For macOS, this option is available in the Help tab on the 
Mac menu bar. This is available to only MiCloud Connect users.

 Access the user guide and training videos. For macOS, this option is available in the Help tab 
on the Mac menu bar.

 Send log files to the Mitel Support. For macOS, this option is available in the Help tab on the 
Mac menu bar.

 Exit the Connect client.

 Dial Pad—Use the dial pad to dial a phone number.

 Quick Dialer Search Bar—Use the quick dialer search bar to search for a name, number, an 
email address, or company name.

 Dashboard—Dashboard is the default and the main navigation pane:
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 <username>—Use the <username> tab to view your profile information. If the Connect client 
is integrated with Microsoft Exchange, it imports your active directory picture which is 
associated with the Outlook. For more information about integrating with Microsoft Exchange, 
refer to Chapter 8, Integrating with Microsoft Exchange/Office 365 on page 88. 

 Contacts—Use the Contacts tab to view your contacts, add a new contact, create groups, and 
add contacts to Favorites or Groups.

 Recent— Use the Recent tab to view your list of incoming calls ( ), outgoing calls ( ), 

and missed calls ( ). It displays calls in chronological order with the most recent at the top.

The date, time, and the call duration are displayed for all incoming and outgoing calls. For the 
current day’s calls, the time and call duration is displayed. For the previous day’s calls, the 
word “Yesterday” is displayed along with the time and call duration. For earlier calls, the date, 
time, and the call duration are displayed.

The consecutive calls made or received from the same number are grouped together, and the 
number of calls are displayed next to the contact name. The badge on the Recent tab 
indicates the number of missed calls.

Click on the user’s name or extension number to view the contact card in the third pane.

 Voicemails—Use the Voicemails tab to view your new, saved, and deleted voicemails. The 
badge on the Voicemails tab indicates the number of unheard voicemail messages.

 Messages—Use the Messages tab to view your chat logs. Click the Messages tab to open 
the conversation details in the Teamwork for Desktop application. The orange dot on the 
message tab in Connect Client indicates that there are new messages received in Teamwork 
for Desktop.
In the Connect Client dashboard, the dot that indicates new messages appears only when the 
Teamwork for Desktop application is in the background. The dot disappears when the 
Teamwork for Desktop application is brought to the foreground.

 Meetings—Use the Meetings tab to view your past and upcoming calendar appointments. 

To view your Outlook appointments, synchronize your Connect client with Microsoft Exchange.
For more information about Synchronizing with Office 365, refer to Chapter 8, Integrating with 
Microsoft Exchange/Office 365 on page 88

You can expand or collapse the dashboard view by clicking the up/down arrow icon. In collapsed 
view, you can mouse hover on each icon to view the tool tip.

Note
Linkedln is no longer integrated with the Connect client. 
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Using the Connect Client Navigating through the Connect Client Interface2

Figure 2:  Dashboard Collapsed View

 —This icon indicates that the connection to the Connect server is secure, and the client is 
sending encrypted data. When this icon is yellow, it indicates that the connection is not secure, 
and the client is sending either encrypted or unencrypted data. Hover over the icon to view the 
tool tip.

 Second Pane—The second pane displays information based on what you select on the 
dashboard. You can resize the second pane manually based on your requirement. This setting is 
retained on the machine you logged in to if you:

 Close and reopen the second pane
 Open the third pane
 Log out of and then log in to the Connect client

 Third Pane—The third pane displays information based on what you select on the second pane. 
For example, if you click a contact on the second pane, the third pane displays the contact card. 
From the contact card you can access the conversation, calls, and voicemail history along with the 
information of the contact.

 Contact Card—View and manage the selected contact.

 Info—View the details of the selected contact.

Note
If the same user logs in to the Connect client from another machine, the second pane opens 
with the default settings and all other settings are lost.
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 Messages—View the conversation history of the selected contact and type your 
messages to the contact.

 Calls—View the call history of the selected contact.

 Voicemails —View the voicemail history of the selected contact.

Click the minimize button at the top-right corner of a pane to close the pane. 

Pinning Tabs for Quick Access
You can pin a tab to the dashboard for quick access. The pinned tab remains open in the second pane 
with the dashboard. While navigating through the other tabs, you can view the pinned tab in the 
second pane after you close the open tabs. You can pin only one tab to the dashboard. 

To pin a tab to the dashboard:

1. On the dashboard, select a tab.

2. Click icon. To unpin the tab, click icon.

Note
The Messages tab does not appear for MiCloud Connect users. MiCloud Connect users can click 

the  icon that appears on the contact card to send messages to contacts on the Teamwork for 
Desktop application.

Note
The third pane is closed automatically if the user clicks any items on the Dashboard. However, if 
there is any active session on going, that session is not lost and can be viewed on the 
Dashboard.
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Connect Client Location
You can set the Connect client to be always on top when navigating through other applications.

For Windows:

1. On the client menu bar, click the Connect drop-down.

2. Select Always On Top.

For macOS:

1. On the Mac menu bar, click Window.

2. Select Always On Top.

Selecting Preferred Language
You can select the language for your desk phone and the Connect client interface.

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Language.

3. On the second pane, from the Deskphone & voicemail menus drop-down list, select the desired 
language for your desk phone.

4. From the I want to use this application in drop-down list, select the required language for the 
Connect client interface.

You must exit and restart the client for the change to take effect.

Setting a Sound Notification
You can create a sound notification to identify a specific event, such as a voicemail, a call from an 
internal or external number, a monitored call, a shared call, or to identify a new or an existing 
conversation.

Note
If you have an operating system in Spanish, French, German, or Simplified Chinese, the 
Connect client uses the same language of the operating system. For other languages, the 
Connect client uses English as the default language. The Mitel collaboration for Web page 
always uses the same language as that of the operating system, regardless of the language 
selected in preferences.
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1. On the dashboard, click  or the <username> tab.

2. From the drop down, Click Settings and then click Notifications.

3. On the second pane, click Sounds.

4. In the Audio Alerts field, select ON.

5. In the For event field, click the drop-down list on the right, and select any of the following:

 New voicemail
 call from an internal number
 call from an external number
 monitored call
 shared line call

6. Select Play alert, click the drop-down list on the right, and select a required sound from the list.

Connect Client Logs
The Connect client creates a log file each time you log in. The logs are used to help Technical Support 
with debugging problems that may arise during the operation. You can send the log files to your 
Connect Administrator while opening a troubleshooting ticket.

To send the client log files:

 For Windows:

1. On the Connect Menu Bar, click the Connect drop-down list.

2. Select Send Client Logs and follow the on-screen instructions.

 For macOS:

1. On the Mac menu bar, click the Help tab.

2. Select Send Client Logs and follow the on-screen instructions.

Connect Collaboration web client logs from iOS device
The Connect Web Collaboration client creates a log file each time you log in from your iOS device. The 
logs provide data that helps Technical Support troubleshoot issues during the sessions. You can 
download the log file for a session using your iOS device and attach the file to a ticket.

Note
Other than the default list of sounds, you can also add or remove a new .wav file.
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Following are the steps to access and download the log files for a Connect Web Collaboration client 
session on your iOS device:

1. Launch “Connect Web Collaboration client” in Safari on the iOS device.

2. Introduce yourself.

3. On the top left corner of the meeting title, tap and hold the meeting title for 2 seconds.

A pop-up dialog box may display depending on your phone setup stating, “This site is attempting to 
open a pop-up windows” message with Allow and Block buttons.

4. Select Allow to open a new page and access the logs from the session.

5. Select the Share button.

6. Choose Create PDF.

7. Click Done.

8. Select Save file to..... to save the file in the desired location.

9. You can attach the file to an email explaining the issue and send it to Mitel technical 
support at ITsupport@mitel.com or to a ticket in the Mitel Global IT Support portal at https:/
/itsupport.mitel.com.

Alternate steps if popup dialog box does not populate:

1. Select the Share button.

2. Choose Create PDF.

3. Click Done.

4. Select Save file to desired location such as your local drive.

5. Attach the log to your IT ticket or email to Mitel IT support.
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Sharing Data with Mitel
The Connect client sends the user interaction data anonymously to Mitel by default. The data is 
analyzed by technical support for enhancing the Connect client application.

To disable sending user interaction data to Mitel:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Accounts.

3. On the second pane, click Access.

4. Clear the Yes, I want to help Mitel build better products! Send anonymous data to Mitel 
option.

You must exit and restart the Connect client for the change to take effect.

Note
All anonymous data is encrypted and cannot be traced back to the user.
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3. Managing Contacts

This chapter provides information on how to manage your contacts.
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Managing Contacts
The Connect client enables you to organize and manage your contacts. 

To view the system directory that shows all the contacts in your organization, click in the Quick Dialer 
Search bar. The contact names with special characters and numbers are displayed first, and followed 
by names in the alphabetical order by the last name with alpha headers. 

To find a contact, type any of the following in the Quick Dialer Search bar:

 First Name
 Last Name
 Email address
 Company name
 Extension number
 Double token (single letter and double letter of the contact’s name). For example, you can type P 

R or Pa Ro to search for Patrick Roberts.

Figure 3 describes the process of adding a contact and viewing the contact’s information.

Figure 3:  Managing Contacts
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Adding a Contact on macOS
1. Do one of the following:

 Click the Recent tab, right-click the contact, and select Add As a Contact. 

 Click the Contacts tab and click  at the top right corner of the second pane, and then select 
Add Contact.

The address book contact form is displayed.

2. Type the contact details in the required fields.

3. Click Done.

You can add an external number to your contact list from the contact card:

1. Type the external number in the Search field, and the contact card opens in the third pane.

2. Click  on the Avatar in the third pane.

Adding a Contact on Windows
You can add a new contact using the Microsoft Outlook contact form and the Connect client contact 
form.

To add contact using the Microsoft Outlook contact form:

1. Do one of the following:

 Click the Recent tab, right-click the contact, and select Add As a Contact. 

Note
The maximum number of contacts you can add in the Connect client is 200 for MiCloud 
Connect customers.

Note
The address book opens only if you have enabled the Connect client in the System 
Preferences on your Mac.

Note
You can add a new contact through Outlook contact form only if:

 Your Connect administrator has configured the Microsoft Exchange account in Connect Director.

 Microsoft Outlook is installed on your computer.



Adding an External Contact on Windows Managing Contacts 3

Connect Client User Guide 29

 Click the Contacts tab and click  at the top right corner of the second pane, and then select 
Add Contact. 

An Untitled Outlook Contact form is displayed.

2. Type the contact details in the required fields.

3. Click Save & Close.

To open the Connect contact form instead of Outlook contact form when adding a contact:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Outlook.

3. On the second pane select the Do not open Outlook when adding contact to Connect option.

To add a new contact using the Connect contact form:

1. Do one of the following:

 Click the Recent tab, right-click the contact, and select Add As a Contact.

 Click the Contacts tab and click  at the top right corner of the second pane, and then select 
Add Contact.

The Contact form opens in the third pane.

2. Type the contact details in the required fields.

3. Click Add Contact.

Adding an External Contact on Windows
You can add an external contact to your contact list from the Connect Client:

1. Click the Recent tab, select the number in the second pane, click  at the top left corner of the 
third pane and the Create Contact page is displayed.

2. Type the number in the Search field, click  at the top left corner of the third pane and the Create 
Contact page is displayed.

3. Type the contact details in the required fields.

Note
If you have installed the Microsoft Outlook on your computer, the Outlook contact form opens by 
default when adding a new contact. However, you can set the Connect client to open the Connect 
contact form instead of Outlook contact form.
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4. Click Create.

Viewing Information of a Contact
1. In the Quick Dialer Search bar, type the contact name or extension number and select the 

contact.

 By default, the system directory search results are displayed.

 If you have enabled the Enable searching for contacts in my exchange public contact 
folders option, you can view the search results from Direct Matches and Exchange Public 
Matches.

 By default, the Connect client displays the search results from Direct Matches.
 To search for a contact from your Exchange Public folders, click Exchange Public 

Matches. From the drop-down list, select the folder, and the contact.

The Contact card opens on the third pane.

2. On the Contact card, click Info to view the contact’s details.

To see the company name, department name, and phone number of a contact:

 From the Quick Dialer Search bar:

a. Right-click the contact on the second pane.

b. Select the Show Company Name, Show Department Name, and Show Phone Number 
options to view or hide the contact information.

 From Favorites and Groups:

a. On the second pane, click .

b. Select the Company Name, Department Name, and Phone Number options to view or hide 
the contact information.

The phone numbers of the contact are displayed in the order; Extension ( ), Business or Work ( ), 

Mobile ( ), and Home ( ). If a contact has configured all the four phone numbers on the Connect 
client, by default, the first two phone numbers in the order get displayed in the second pane. 

Note
You cannot add any external number using Microsoft Outlook contact form.

Note
For more information about the Enable searching for contacts in my exchange public contact 
folders option, see To enable searching for the contact from the Exchange Public Contact folders: 
on page 93.
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To view all the phone numbers, click More. The Contact card opens on the third pane. Click Info where 
all the phone numbers and email id of the contact are displayed.

Importing the Contact Folders
For macOS, you can import the contact folders from the Mac address book into the Connect client. If 
the Microsoft Outlook is installed on your computer, the Mac address book synchronizes with the 
Microsoft Outlook or Office 365 contact folders.

To import the contact folders from the Mac address book:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Contacts/Outlook.

3. On the second pane, click Sync my Mac Contacts.

4. Click +Show contact folders and select the folders that you want to import into the Connect 
client.

For Windows, if you have integrated the Connect client with Microsoft Exchange, you can import the 
contact folders from Microsoft Outlook or Office 365 into the Connect client. For information about 
importing the contact folders from Microsoft Outlook or Office 365 into the Connect client, refer to 
Synchronizing the Connect client with Microsoft Outlook or Office 365 Contact Folders on page 92. 

Editing an External Contact
1. In the Quick Dialer Search bar, type the contact name or the number.

2. From the search results, click the contact name that you want to edit.

3. The contact card opens in the third pane, click Info on the contact card.

4. Click Edit, and update the fields.

5. Click Save to confirm the update.

Deleting a Contact
To delete a contact from Connect client when it is not integrated with Outlook:

Note
The More option is displayed only if the contact has configured more than two phone numbers.

Note
You must enable the Connect client in the System Preferences on your Mac to import the contacts 
from the Mac address book.
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1. In the Quick Dialer Search bar, type the contact name or extension.

2. Click the name of the contact that you want to delete.

3. Click Info on the contact card.

4. Click Delete.

5. In the confirmation dialog box, click Delete.

You can delete the contacts imported from the Outlook all at once using the Connect client interface.

To delete the contacts imported from Outlook:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Outlook.

3. On the second pane, click Remove Synced Contacts.

4. In the confirmation dialog box, click Remove. 

All your contacts imported from Outlook are deleted at once. The Remove Synced Contacts 
option is disabled and the Sync my Outlook contacts option is cleared.

Deleting an External Contact
1. In the Quick Dialer Search bar, type the contact name or number.

2. From the search results, click on the contact name that you want to edit.

3. The contact card opens on the third pane, click Info on the contact card.

4. Click Delete.

5. In the confirmation dialog box, click Delete.

Adding a Contact to your Favorites List
1. In the Quick Dialer Search bar, type the contact name or extension.

2. From the search results, click the Star icon next to the contact name that you want to mark as 
favorite.

Alternatively, you can mark a contact as favorite by clicking the Star icon on the Avatar in the third 
pane.

Note
You can delete only the external contacts that you have added to the Connect client. However, 
you cannot delete contacts available through the system directory of your organization.
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You can mark a contact favorite from both Direct Matches and Exchange Public Matches. 

To remove the contact from the favorites list, click the Star icon next to the contact name or on the 
Avatar.

Viewing Favorites
1. Click the Contacts tab on the dashboard.

2. Click the Favorites tab on the second pane to view the list of contacts marked as favorites.

In Favorites and Groups lists, you can see the contacts in List mode and Compact mode. On the 

second pane, click  to view in List mode, and click  to view in Compact mode.

 List Mode: The contact’s name, extension number, phone number, department name, and 
availability status are displayed. 

 Compact Mode: The contact’s name and availability status are displayed.

Searching Contacts
You can search the contacts added to your Favorites or Group. To search a contact, enter the contact’s 
name, or extension in the Search field in the Favorites or Group tab.

The search results open on the second pane displaying the contact’s name, availability status, 
extension number, and phone number.

If the contact is online and has set an additional note to the availability status, the additional note is 
displayed. If the contact is offline, the availability status is unknown.

For more details about viewing information of a contact, refer to Adding an External Contact on 
Windows on page 29.

Sorting Contacts
You can sort the contacts in your Favorites and Groups list by last name, first name, availability state, 
and last contact.

To sort your contacts in Favorites or Groups:

1. On the dashboard, click Contacts> Favorites.

2. On the second pane, select Favorites or Groups.

3. Click  and select one of the following:

 Last Name
 First Name
 Availability
 Last Contact
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Viewing Call Stack Information of a Contact
You can view the availability state and call stack information of a contact if the contact is added to your 
Favorites or Groups list. To view the call stack information, do one of the following:

 Click Contacts > Favorites or Groups. Hover on a contact to view the tool tip. 

Tool tip displays the contact’s availability state and call stack information. 

 Open the contact card and click at the top right corner of the contact card to view the contact’s 
availability state and call stack information. 

If the contact has included an additional note to the availability status, the additional note will be 
displayed instead of the default status.

You can answer the Incoming calls, Parked calls, and On Hold calls from the contact’s call stack. To 
answer a call from the call stack of a contact, refer to Exporting Call Data on page 54

Managing Contact Groups

Creating a Contact Group
1. On the dashboard, click Contacts > Groups.

2. On the second pane, click  and select Add Group.

3. In the Group Name field, type the group name.

4. In the Group Members field, do one of the following:

 Type the contact name and select the contact. 

5. In the Quick Dialer Search bar, type the contact name or number, and then drag the contact from 
the search results to the People field.

6. Click Create to save the group, or Discard.

Reordering the List of Contact Groups
1. Click the Contacts tab on the dashboard.

2. Click the Groups tab to view all the groups created.

3. Click the group header and drag it to the required position.

Note
You can use the More option to list the complete members for larger numbers.
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Any changes to the order of groups is persistent between the client restarts.

You can hide or view members for a particular group. Click on the group header to expand or 
collapse the group.

Editing or Deleting a Contact Group
1. On the dashboard, click Contacts > Groups.

2. Click  on the group header you want to edit.

3. Click  next to the group name.

4. In the Group Name field, edit the group name.

5. In the Group Members field:

 To add a contact to the group, type the contact name and select the contact.

 To remove a contact from the group, click x next to the contact.

 To reorder the contact names, select a contact, drag the selected contact to the required order.

6. Click Save to save your changes, or click X at the top-right corner of the third pane, and in the 
confirmation dialog box, click Discard to remove the user changes.

To delete a group, do the following:

1. On the dashboard, click Contacts > Groups.

2. Click  on the group header you want to delete. The group expands in the third pane.

3. Click  next to the group name in the third pane, and click Delete.

4. In the confirmation dialog box, click Delete to confirm the group deletion.

Tip
Type the contact name or the number in the Quick Dialer Search bar, and right-click the 
contact on the second pane, and select Add Contact to Group to add the contact to the 
required group.
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4. Managing Availability States

This chapter provides information about managing availability states for users and their contacts.
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Selecting a Predefined Availability State ............................................................  40
Adding a Note to Availability States ....................................................................  40
Configuring a Custom Availability State..............................................................  40

Allowing a Contact to Manage your Availability State ...............................................  41
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Understanding Availability States
You can check or verify the availability status of a contact on the Connect client before communicating 
with that contact. The Connect client automatically updates the availability status of users as they 
make and receive calls. When integrated with Microsoft Exchange, the Connect client also displays 
users’ meeting status.

You can monitor the availability of up to 500 contacts. This can be configured by your Connect 
administrator. 

The different availability states are described in Table 2.

Table 2:  Availability States

Color State Predefined/
Customizable Description

Green Available Predefined The contact is available for a call or IM session.

Yellow In a Meeting Predefined The contact is in a meeting, but you can still reach the 
contact through an IM session. If you dial this contact, 
the call will be routed to the contact’s voicemail inbox or 
to the number configured using the availability routing 
as explained in Playing Envelope Information for 
Voicemail on page 75.

Red Out of Office Predefined If you dial this contact, the call will be routed to the 
contact’s voicemail inbox or to the number configured 
using the availability routing, as explained in Playing 
Envelope Information for Voicemail on page 75.

Red Do Not Disturb Predefined The contact is busy and does not wish to be reached. 
However, you can reach this contact through an IM. If 
you dial this contact, the call will be routed to the 
contact’s voicemail inbox or to the number configured 
using the availability routing, as explained in Playing 
Envelope Information for Voicemail on page 75.

Red Vacation Predefined If you dial this contact, the call will be routed to the 
contact’s voicemail inbox or to the number configured 
using the availability routing, as explained in Playing 
Envelope Information for Voicemail on page 75.

Gray Custom... Customizable The contact has a custom status, depending on the 
configured option. If you dial this contact, the call will be 
routed to the contact’s voicemail inbox or to the number 
configured using the availability routing, as explained in 
Playing Envelope Information for Voicemail on page 75.
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Setting Alert for Contact’s Availability State
If you want to communicate with a contact who is currently not in Available state, you can set the 
Connect client to notify you when the contact’s status changes to Available. 

To receive a notification do either of the following:

1. In the Quick Dialer Search bar, type the contact name or extension, and select the contact. In 

Contact Card, click  and select Alert When Available.

2. If the contact is added to your Favorites or Groups list, right-click the contact in Favorites or 
Groups tabs, and select Alert When Available.

3. In the Quick Dialer Search bar, type the contact name or extension, right-click the contact in 
second pane, and select Alert When Available.

Orange Ringing Predefined When you receive an incoming call, the availability 
state flickers and changes to orange.

On the Phone Predefined When you answer an incoming call, the availability 
state changes to orange.

When you are already on a call and receive another 
incoming call, the availability state starts flickering and 
changes to Ringing.

Table 2:  Availability States

Color State Predefined/
Customizable Description
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A notification appears on the dashboard alerting you when a contact becomes available.

Figure 4:  Alert when Available notification

You can set the alert only for the contacts available through the system directory of your organization. 
However, you cannot set this alert for any external contacts that you have added to the Connect client.

Note
Alerts are disabled when the Connect client restarts or quits.
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Changing Availability State
The Connect client automatically updates your availability state when you use the system, but you can 
select a predefined Availability state or configure a custom availability state. 

Selecting a Predefined Availability State
1. On the dashboard, click the drop-down menu below the <username>.

2. Select one of the following availability states:

 Available
 In a meeting
 Out of office
 Do not disturb
 On vacation

A check mark is displayed next to the current set state.

Adding a Note to Availability States
You can add a custom note to each availability state on Connect client.

To add or edit an availability state note: 

1. On the dashboard, click  or the <username> tab

2. In the drop-down, hover over the selected availability state, and click .

3. In the Additional Note field, enter the description.

You can enter description up to 50 characters.

4. Click Done to save the changes, or Cancel to discard.

If you do not want to add or edit the note, click Back to go back to the availability state drop-down 
menu.

Configuring a Custom Availability State
1. On the dashboard, click the drop-down menu below the <username>.
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2. In the drop-down, click Custom and select one of the availability state color: 

 Green - Available
 Yellow - Busy
 Red - Not available

3. Enter your custom status. Click Done to save changes, or Cancel to discard.

Click Back to go back to the availability state drop-down menu.

The custom availability status and color is displayed on the <username> tab. 

Allowing a Contact to Manage your Availability State
You can configure a contact to manage your availability state on the Connect client. 

 To manage your availability state, the contact must have added you to a contact group.

To allow access to a contact to manage your availability states:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Account.

3. On the second pane, click Access.

4. Type in the contact name for whom you want to allow access, and close the page.The contact is 
configured to change your availability state until you revoke access by removing the contact from 
the Access page.

Note
The color of the availability state cannot be customized.

Note
To view your availability state in Microsoft Outlook after integration with the Connect client, ensure that 
you launch the client before launching Outlook on Windows.
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5. Managing Phones

This chapter provides information about managing your desk phone, softphone, and external phones.
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Assigning your Desk Phone ...............................................................................  43
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Removing the Desk Phone Assignment .............................................................  44
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Customizing the Softphone ................................................................................  45

Assigning External Phones .......................................................................................  46
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Managing your Desk Phone
This section provides information about assigning a desk phone to your Connect client.

Assigning your Desk Phone
1. On the desk phone, press the Assign soft key.

2. In the Extension field, enter your assigned extension number, and press Next or the down key.

3. In the Voicemail password field, enter your voicemail password, and press OK or the # key.

4. Verify the desk phone status in the Connect client as follows: 

a. Launch the Connect client.

b. Verify the status on the dashboard:

 If the deskphone is successfully assigned,  is displayed on the dashboard next to the 
<username>.

 If the Desk Phone icon is not displayed, then repeat steps 1 to 3.

c. Verify the desk phone status under Primary Assignment.

 Click the <username> tab.

 From the drop-down, in the Primary Assignment, verify if the Desk phone option is 
displayed.

Customizing your Desk Phone

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Deskphone.

3. On the second pane;

 In the Wallpaper field, in the drop-down list, select the preferred wallpaper.

 In the Ringtone field, in the drop-down list, select the preferred ringtone.

Note
When using a Mitel 6900 series IP phone, wallpaper and ringtone must be set on the phone, not in the 
Connect client.
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Removing the Desk Phone Assignment

1. On the dashboard, click  or the <username> tab.

2. Click Primary Assignment.

3. To reset the current extension assignment, click Go Back To My Desk Phone.

The deskphone option is removed from the Primary Assignment. The corresponding extension 
number is also unassigned from the desk phone.

Using the Softphone
When you select softphone as your primary assignment, incoming calls are routed to the Connect 
client. The desk phone functionality is disabled until you assign your desk phone again to the Connect 
client.

Assigning Softphone

1. On the dashboard, click  or the <username> tab.

2. In the Primary Assignment, select softphone.

If the Softphone option is not displayed, contact your Connect administrator.

3. Select one of the following from the drop-down list:

 Default
 Communications 

Communications device option is available only in Windows.
 Microphone
 Headset Microphone

The Headset option is shown in the drop-down list only after you plug a headset into your 
computer.

After the softphone is successfully assigned,  is displayed on the dashboard next to the 
<username>.

Note
If you are a MiCloud Connect user, then you must have a DID number assigned to your account to use 
the Softphone feature in the Connect client.
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Customizing the Softphone

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Primary Assignment.

3. Select Softphone.

4. If you do not see the Softphone tab, contact your Connect administrator.
To switch to a different available audio device, in the Capture audio through field, select your 
preferred microphone and the speaker device from the drop-down list.

5. Select On startup assign me to my softphone to handle calls and voicemails on the softphone 
from the time you first log in to the client.

6. Select Enable auto gain control to enable the automatic control.

Tip
You can also change the preferred device by doing the following: 

 Click Settings, and then click Softphone.

 In the second pane under Capture Audio through, select the preferred microphone and the 
speaker device from the drop-down list.

Note
A variety of Plantronics and Jabra headsets are supported with the Connect client on MiCloud 
Connect. The following functions are supported:

 Answer and end calls
 Mute and unmute calls
 Hold and resume calls
 Ring indication

The following features are not supported:

 Intercom
 Bridged Call Appearance

For more information, see https://oneview.mitel.com/s/article/What-are-the-supported-headsets-for-
Softphone-and-IP-Phones.

https://oneview.mitel.com/s/article/What-are-the-supported-headsets-for-Softphone-and-IP-Phones
https://oneview.mitel.com/s/article/What-are-the-supported-headsets-for-Softphone-and-IP-Phones
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Assigning External Phones

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings, and then click Primary Assignment.

3. Select External Assignment Number.

4. In the Add Label field, enter a name for the number. For example, Home or Mobile.

5. In the Add Number field, enter the phone number.

If you enter the format of the number incorrectly, the Cannot save this number pop-up message 
is displayed.

You cannot use a phone number that is assigned to Connect for iOS or Android.

6. In the Number of Rings field, select a number from 1 through 20. By default, the number of rings 
is set to 3.

7. To choose a method to connect to the external number, click the drop-down list and select one of 
the following:

 Automatically connect
 Press 1 to connect

8. Click Add.

After the external number is successfully assigned,  is displayed on the dashboard next to the 
<username>.

To add a new number, click Add New Number. 

To delete a number, select the number from the drop-down list and click Edit. In the Edit Number 
field, click Remove to delete, or click Keep Number to retain it.

If you have more than one external number, you must select one number from the drop-down list to 
assign to the Connect client. 

You can select the number of rings after which you want the calls to be routed to voicemails. 

Note
The Connect administrator can enable, disable, or configure the external assignment option from 
Connect Director. 

Note
You can add up to seven external numbers, and assign your extension to any one number.



Assigning External Phones Managing Phones 5

Connect Client User Guide 47

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Call Routing.

3. On the second pane, click Availability Routing.

4. Click Change next to the rings before incoming calls are routed to the voice mail routing 
option.

5. Select 6 or more rings from the rings before forwarding drop-down list.

6. Click Save.
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6. Managing Calls

This chapter provides information about making voice calls and using related features in the Connect 
client.
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Making a Voice Call
You can make a call from:

 Quick dialer search bar
 Directory
 Recent
 Dial pad
 Outlook-Webmail/MS Teams 

To make a call from the quick dialer search bar or from the system directory:

1. Type the contact details in the quick dialer search bar on the dashboard.

Enter the first or last name, extension, company name, department name, phone number, or an 
email address of the person you would like to search for. For more information about searching for 
a contact, refer to Adding an External Contact on Windows on page 29.

2. Do one of the following:

 Double-click the contact in the second pane.

 Click the contact, and click  in the third pane, which dials the default number of the user.

If the user has configured more than one number, to call the user at a particular number, click 

 in the third pane, and select the number.

To attach a account code for the call, 

a. In the third panel click , and then click Call with Account Code.

b. Enter an account code or select from the list, and then press Enter.
For more information on account codes see Account-Codes.

To make a call from the recent tab:

1. Click the Recent tab on the dashboard.

Note
The user must dial the area code followed by the telephone number for a call to be 
connected.

If the user dials a 7-digit number, an automated recording prompts the user to dial 10 digits 
and the call is disconnected.

https://oneview.mitel.com/s/article/MCSS-Account-Codes
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2. Do one of the following:

 Double-click the contact in the second pane.

 Click the contact, and click  in the third pane.

To make a call from the dial pad:

1. Click on the dashboard.

2. Enter the extension or the mobile number, and press enter.

To make a call from Outlook-Webmail or MS Teams:

1. In the Outlook-Webmail or MS Teams, click the number you want to dial.

2. On the warning pop-up, click Open.
The Connect client opens with pre-filled quick dialer.

3. Click  in the third pane.

Note

 Install Mitel Web Extension. See Mitel Web Extension Online Help for information on how to install 
the Mitel Web Extension.

 Set the Connect client as default telephony application in your system settings.

To set is as default application;

1. Navigate to Settings > Apps.

2. On the right hand side, click Default apps.

3. Click Choose default apps by protocol.

4. Under Tel, select Mitel Connect as default App.

https://www.mitel.com/document-center/technology/cloudlink/all-releases/en/mitel-web-extension-html
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Answering a Voice Call
The Connect client displays a call notification on the dashboard for every incoming call. If you have 
enabled the system notification for incoming calls, the Connect client also displays a system 
notification with the following information:

 Name of the Contact. If the caller is not listed in the system directory of your organization, the 
name is displayed as Unknown.

 Phone Number

 Dialed Number Identification Service (DNIS) if available

To enable the system notification for an incoming call, refer to Managing Incoming Call 
Notifications on page 53.

To answer an incoming call, do one of the following:

 On the system notification, click Accept to answer or Ignore to send the call directly to voicemail.

 On the dashboard, click  to answer, and click to directly transfer the call to voicemail. 

To reject the call and respond through IM, click  and type the message or select the canned 

message, and click Send. Click  to end the active call.

 Use shortcut keys,

 On Windows, press Ctrl + A

 On macOS, press Cmd + A

 To answer a call using the Plantronics headset:

Note
For users with Extension only license, only Accept button is displayed on the system 
notification.

Note
When there are multiple calls ringing, pressing the shortcut keys answers the first call in the UI 
stack.

Note
You must install the Plantronics hub. If you do not install the Plantronics hub or the hub is 
down, the headset acts as a normal audio device, and you cannot use the headset buttons to 
perform call functions. To download and install the Plantronics hub software, refer to the 
Plantronics website.
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 Set your extension to Softphone. (For more information, see Assigning Softphone on page 
44.)

 Press the call answer button on your headset. 

You can use the call control functions available on your headset. For more information, refer to 
the Plantronics website.

To attach a account code for the call, 

a. After the call is connected, in the second panel click , and then click Call with Account 
Code.

b. Enter an account code or select from the list, and then press Enter.
For more information on account codes see Account-Codes.

You can place a voice call on hold and resume when required. 

 In the call notification area, click  to place the call on hold and click  to resume.

 On the contact card, click  to place the call on hold and click  to resume.

You can send a call note on an active call. For more information about adding a call note, refer to 
Managing Call Notes and Viewing Routing Slips on page 63.

Managing Incoming Call Notifications
To receive a system notification for an incoming call:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Notifications.

3. On the second pane, click Popup.

4. To enable notifications, select the Show a system notification for an incoming Call check box.

5. In Keep notification on screen for field, select the time from the drop-down list.

https://oneview.mitel.com/s/article/MCSS-Account-Codes
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Exporting Call Data
Users can export the call history details and the associated call notes by using the ‘Export Call Data’ 
feature. To export the call data, do the following:

1. Click the Recent tab on the dashboard.

2. Under the All tab in the second pane, click .

3. Use the  drop-down menu to do the following:

 Today - Export the entire call history with the contacts for the present day.

 Last week - Export the entire call history with the contacts for the last seven days.

 Last month - Export the entire call history with the contacts for the last month.

4. Click the Export button from the drop-down menu.

The Save As dialog box is displayed. The default file format is .csv, and the default path for saving 
the file is C:\Users\<user>\Downloads.

5. Enter the file name, and select the location or accept the default location, and click Save.

6. Locate the file on your computer, and double-click to open the .csv file, or you can rename the file 
in the .xlsx format and open it.

7. Review the information about the call data.

Answering Call from Call Stack of a Contact

You can answer incoming calls, parked calls, and calls on hold from a contact’s call stack.

To answer a call:

1. View the call stack of a contact. Refer to Viewing Call Stack Information of a Contact on page 34 
for information about call stacks.

2. Click  beside the call you want to answer.

When you answer a call from the contact’s call stack, the answered call is removed from the 
contact’s call stack and appears on your call stack.

Note
This option is available only if your Connect administrator has enabled the Allow Call Pick Up and 
Show Caller ID name and number for other extensions options in Connect Director.
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Viewing Call Interaction History with a Contact
1. In the Quick Dialer Search bar, type the name or extension number and select the contact.

2. In the third pane, click Calls.

In the drop-down, by default, All is selected. It displays the entire call history with the contacts.

To view only the missed calls, select Missed in the drop-down.

Your call history with the selected contact is displayed in the third pane. Click each call entry to 
view the call origin, the call duration, the call routing slip, and to enter a call note.

Transferring a Call
The Connect client allows you to do the following kinds of transfer operations or other actions related 
to transfers:

 Blind Transfer
 Consultative transfer
 Park
 Intercom
 Whisper
 Voicemail

Note

You can also answer the parked calls from the contact card. Click , in the pop-up window 

click  to answer the call.
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Figure 5 describes the different types of call transfer options; Transfer, Consult, Park, Intercom, 
Whisper, and Voicemail options.

Figure 5:  Transferring a Call

Transferring a Call Using the Blind Transfer Option
In Blind Transfer, you cannot to talk to the person that you want to transfer the call to, prior to making 
the call transfer. You can do the blind transfer using the drag and drop option, the contextual menu, 
and from the call notification area.

Note
You can do the blind transfer either before or after answering a call. To answer a call, see 
Answering a Voice Call on page 52.
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To do a blind transfer using the drag and drop option:

1. In the Quick Dialer Search bar, type the contact name or the extension number.

2. On the dashboard, drag the call from the call notification area and drop it on the contact in the 
second pane.

To do a blind transfer using the contextual menu:

1. In the Quick Dialer Search bar, type the contact name or the extension number.

2. Drag the call from the call notification area and hover over the contact for two seconds to view the 
contextual menu. Select Blind transfer from the contextual menu to complete the call transfer.

To do a blind transfer from the call notification:

 Before answering the call:

a. On the dashboard, click  in the call notification.
Alternatively, you can press Ctrl + T on a Windows machine or Cmd + T on a Mac machine.

b. In the second pane search field, type the contact name or the phone number.

c. Click Transfer.

 After answering the call:

a. In the second pane, click .
Alternatively, you can press Ctrl + T on a Windows machine or Cmd + T on a Mac machine.

b. In the second pane search field, type the contact name or phone number.

c. Click Transfer.

Transferring a Call Using the Consult Option
In consultative transfer, you can to talk to the person that you want to transfer the call to, prior to 
making the call transfer.

 Before answering the call:

Note
Under Groups and Favorites if the contact list is long, you can drag the call to the list and scroll 
through the list to locate the contact to whom you want to transfer the call.

Note
 Pressing the shortcut keys will perform the transfer action for the connected call.
 If there are multiple calls, the most recent call will be transferred.
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a. On the dashboard, click  in the call notification.

Alternatively, you can press Ctrl + T on a Windows machine or Cmd + T on a Mac machine.

b. In the second pane search field, type the contact name or the phone number.

c. Click Consult. 

d. In the Consulting window, click  to complete the call transfer.

 After answering the call:

a. In the second pane, click . Alternatively, you can press Ctrl + T on a Windows machine or 
Cmd + T on a Mac machine.

b. In the second pane search field, type the contact name or phone number.

c. Click Consult. The active call goes on hold and the Consulting window appears.

d. Click to complete the call transfer.

Parking a Call
You can park a call using the contact card or the contextual menu. If the call is not answered at the 
specified extension, the call is returned to you with the routing slip indicating that you have already 
spoken to this caller.

To park a call using the contact card:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 52.)

2. In the second pane, click .

3. In the second pane search field, type the contact name or phone number.

4. Click the Park option.

5. Click  to park the call.

To park a call using the contextual menu:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 52.)

2. In the Quick Dialer Search bar, type the contact name or number and select the contact.

3. Drag the active call in the notification area and hover over the selected contact for two seconds to 
view the contextual menu.

4. Select Park from the contextual menu to complete the call transfer.
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appears next to the contact name indicating that the call is parked on the contact’s call stack.

Park and Page
To park a call and page a contact:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 52.)

2. In the second pane, click .

3. In the second pane search field, type the contact name or phone number.

4. Click the Park option.

5. Click to park and page the call.

Park and Intercom
You can use the park and intercom option to place an intercom call in which the recipient phone 
automatically answers with mute activated and broadcasts your message through the recipient’s 
speaker phone, headset, or handset. 

To park and intercom a call:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 52.)

2. In the second pane, click .

3. In the second pane search field, type the contact name or phone number.

4. Click the Park option.

5. Click to park the call and place an intercom call to the selected contact.

Transferring a Call Using the Intercom Option
 Before answering the call:

a. On the dashboard, click  in the call notification.
Alternatively, you can press Ctrl + T on a Windows machine or Cmd + T on a Mac machine.

b. In the second pane search field, type the contact name or the phone number.

c. Click Intercom. 

d. On the Consulting window, click to complete the call transfer.
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 After answering the call:

a. In the second pane, click .Alternatively, you can press Ctrl + T on a Windows machine or 
Cmd + T on a Mac machine.

b. In the second pane search field, type the contact name or phone number.

c. Click Intercom. The active call goes on hold and the Consulting window appears.

d. Click to complete the call transfer.
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Transferring a Call Using the Whisper Option
 Before answering the call:

a. On the dashboard, click in the call notification.

b. In the second pane search field, type the contact name or the phone number.

c. Click Whisper. 

d. On the Consulting window, click to complete the call transfer.

 After answering the call:

a. In the second pane, click .Alternatively, you can press Ctrl + T on a Windows machine or 
Cmd + T on a Mac machine.

b. In the second pane search field, type the contact name or phone number.

c. Click Whisper. The active call goes on hold and the Consulting window appears.

d. Click to complete the call transfer.

Transferring a Call to Voicemail 

On the dashboard, click in the call notification to transfer the call directly to your voicemail without 
answering the call.

To transfer the call to another contact’s voicemail:

1. On the dashboard, click  in the call notification to answer the call.

2. In the second pane, click .
Alternatively, you can press Ctrl + T on a Windows machine or Cmd + T on a Mac machine.

3. In the second pane search field, type the contact name or phone number.

4. Click Voicemail. The active call goes on hold and the Consulting window appears

5. Click to complete the call transfer to voicemail.
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Making a Conference Call
A conference call involves more than two parties connected in a call. The number of people you can 
conference together in a call depends on your system configuration. Contact your Connect 
administrator for the details about your system’s conference capabilities.

You can set up a conference call using either of the following approaches:

 In a blind conference call, you conference the people together without the other person first 
answering your call.

 In a consultative conference call, you talk to the person before adding that person to the 
conference call.

Creating a Blind Conference Call
To do a blind conference using the contact card:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 52.)

2. In the second pane, click .

3. In the second pane search field, type the contact name or extension and click Conference.

To do a blind conference using the contextual menu:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 52.)

2. In the quick dialer search bar, type the contact name or number and select the contact.

3. Drag the active call in the notification area and hover over the selected contact for two seconds to 
view the contextual menu.

4. Select Conference Blind from the contextual menu to initiate the conference.

Creating a Consultative Conference Call
To do a consultative conference call:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 52.)

2. In the second pane, click .

3. In the second pane search field, type the contact name or extension and click Consult.

The active call is placed on hold automatically, allowing you to consult the third person.

4. Click to initiate the conference call.
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Creating an Intercom Conference Call
You can add a participant to an active call by placing the active user on hold and then using the 
intercom conference feature to call the third user without ringing the phone line.

To do an intercom conference call:

1. Answer an incoming call. (To answer a call, see Answering a Voice Call on page 52.)

2. In the second pane, click .

3. In the second pane search field, type the contact name or extension and click Intercom.

The active call is placed on hold, and the call to the third user is automatically answered on the 
phone line.

4. Click icon to initiate a conference call.

Managing Call Notes and Viewing Routing Slips
Call note allows you and the other members on the call to add, view, and edit notes for an incoming 
call, a call that is on hold, and an active call.

Routing Slips displays the history and call routing details of the call. 

Table 3 describes the various call note and routing slip status for an incoming call, call on hold, and 
active call.

Table 3:  Call Note and Routing Slip Status
Icon Description

Indicates that the return routing 
slip is open.

This icon is displayed when the 
call that you parked is returned to 
you and when the routing slip is 
open.

Indicates that the return routing 
slip is closed.

This icon is displayed when the 
call that you parked is returned to 
you and when the routing slip is 
closed.
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To enable routing slips and call notes:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Telephony.

3. On the second pane, click Popup.

4. Select Show access to routing slip and call note for each call in the dashboard.

The call stack displays routing slip and call note icons.

Indicates that the routing slip is 
closed.

To open, click the icon.

Indicates that the routing slip is 
open.

If there is only one call, by default, 
the routing slip of the call is open.

If there are multiple calls, by 
default, the routing slip is open 
only for the oldest call on the 
dashboard. For the other calls, 
click the icon to open the routing 
slip.

Indicates that the call note is 
closed and there is no text.

To open, click the icon. You can 
add the text to the call note.

Indicates that the call note is open 
and there is no text.

You can add the text to the call 
note.

Indicates that the call note is 
closed and it has text.

To open, click the icon. You can 
then view or edit the text.

Indicates that the call note is open 
and it has text.

You can view or edit the text.

Icon Description
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You can click  to view or hide the routing slip and click  to view or hide the call note for a call. 

You can also edit the previous call note during an active call.

Making a Video Call
To make a video call, the Primary Extension must be assigned to your Softphone. (For details about 
how to assign your extension to the softphone, see Assigning Softphone on page 44.)

1. Find and select a contact. (For more information, see Managing Contacts on page 27.)

2. To make a voice call, do one of the following:

 In the third pane, click .

 In the search results, double-click the contact.

 From Favorites or Groups, double-click the contact.

3. To start broadcasting your video to the other party, click .

A select layout button appears on the third pane, when a screen share and a video call are active at 

same time. Click  drop-down to share:

 All
 Data
 Video

with other members on the video call. (For more information on Screen sharing, see Sharing Screens 
with a Contact on page 112.)

4. To end the video, click Turn off Video Camera icon.

Note
By default, the routing slip is open for the oldest call on the dashboard. For the other calls, click 

to open it.
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Setting Up Video Camera Preferences
You can set up the Connect client to use the video camera:

 By default
 Prompt you to turn on the camera
 Wait for you to activate the camera manually, which lets you have complete control of your video 

camera.

To set up the video camera:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Video.

3. On the second pane, click Permissions.

4. Select one of the following video options:

 Automatically start my camera without asking
 Ask me if I want to use my camera
 Never ask me, I’ll turn the camera ON myself

5. Click Video > Camera Setup, and select the video device from the drop-down list. (You can view 
a preview from the selected video device.)

Managing Voicemail
Callers can leave a voicemail message if a call is not answered. The voicemail message is delivered to 
your assigned desk phone, the Connect client, and your email inbox.This section includes the following 
topics:

 Forwarding Calls to your Voicemail Inbox on page 67
 Leaving a Voicemail Message on page 67
 Accessing Voicemail Messages on page 68
 Viewing Voicemails from a Contact on page 69
 Listening to a Voicemail Message on page 69
 Saving a Voicemail Message on page 69
 Replying to a Voicemail Message on page 70
 Forwarding a Voicemail Message on page 70
 Deleting a Voicemail Message on page 71
 Restoring a Deleted Voicemail Message on page 71
 Configuring Email Notifications for Voicemail Messages on page 71
 Managing System Notifications for Voicemail Messages on page 71
 Changing your Voicemail Password on page 72
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Forwarding Calls to your Voicemail Inbox

When you receive an incoming call that you don’t want to answer, click in the notification area. 
The caller is directed to record a voice message.

After a caller leaves a voicemail message, you receive a badge notification on the Voicemail tab on the 
dashboard and on the Connect client icon on your computer task bar.

Leaving a Voicemail Message
1. Dial a contact. (For more information, see Making a Voice Call on page 50.)

2. When you are prompted to leave a voicemail message, record your message.

Sending a Group Voicemail

1. On the dashboard, click  or the <username> tab. 

2. Click the Groups tab, and click  on the group header to which you want to send a voicemail.

3. Click Send Voicemail.

4. To record the message through the desk phone, click .

To record the message through the computer speaker, click .

5. To start recording the message, click .

To stop recording, click .

To play the recorded message, click .

6. Enter a title for your recording in the Subject field.

7. Specify any of the following options for the message:

Note
To alert you about an incoming voicemail message you can set an email notification or a system 
notification. For more information, see the following topics:

 Configuring Email Notifications for Voicemail Messages on page 71
 Managing System Notifications for Voicemail Messages on page 71
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 Urgent—recipient can see an exclamation (!) mark next to the voicemail.

 Private—recipient cannot forward a private voicemail.

 Receipt—sends an acknowledgment to the sender when the recipient has listened to the 
voicemail.

8. Click Send.

Accessing Voicemail Messages
Each voicemail displays the following:

 Name and number of the voicemail sender.

 Date on which the voicemail was received. If you receive it on the current day, “Today” is displayed 
along with time and duration.

 Duration of the voicemail. 

 Icons to indicate Saved ( ), Private ( ), and Urgent ( ) voicemails.

To access a voicemail message:

1. On the dashboard, click the Voicemails tab.

2. To access the voicemail messages for a specific category:

 Click the All tab to view all (heard, unheard, and saved) the voicemail messages. The unheard 
voicemail messages are displayed in bold font, and preceded by a blue dot. 

 Click the Unheard tab to view the unheard voicemail messages along with the duration.

 Click the Saved tab to view the saved voicemail messages that you have marked for easy 
retrieval. 

You can choose to reply, forward, save, or delete the received voicemails.

Click on the user’s name or extension number to view the contact card in the third pane. 

To mark the message as heard or unheard, right-click the voicemail message and select Mark as 
Heard or Mark as Unheard.

3. The Deleted Voicemails tab is displayed only if you have any deleted voicemail messages. To 
access the deleted voicemails, click on the Deleted Voicemails header. By default, the Deleted 
Voicemail tab is in collapsed view and displays the number of deleted voicemails on the header.

Note
You cannot mark the Workgroup voicemail messages as heard or unheard.
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From the Voicemail tab, you can add the contact from whom you have received a voicemail message 
to your Favorites or Groups list. Right-click the contact's voicemail message, and select Add Contact 
to Group. From the drop-down list, select <group name> to which you want to add the contact. 

Viewing Voicemails from a Contact
1. In the Quick Dialer Search bar, type the name or extension number and select the contact.

2. On the Contact card, click Voicemails.

All voicemails from a selected contact are displayed in the third pane. Click each voicemail entry to 
reply, forward or delete the voicemail.

Listening to a Voicemail Message 
1. On the dashboard, click the Voicemails tab.

2. In the second pane, select the voicemail.

3. Click to play the message through desk phone or to play through the computer speaker.

4. Click  to play the voicemail message, and click  to pause the voicemail message. 

Use the progress indicator to skip forward or backward within the message.

You can choose to reply, forward, or delete the received voicemail.

Saving a Voicemail Message
1. On the dashboard, click the Voicemails tab.

2. On the second pane, click the All tab.

3. Right-click the voicemail you want to save, and select Save Voicemail. 

The save icon  is displayed next to the voicemail name.

To remove the voicemail from the Saved list, right-click the voicemail you want to remove, and select 
Unsave Voicemail.

Note
If a voicemail message is marked as private, the computer speaker and the deskphone speaker 
options are disabled. The private voicemail message can only be played through the deskphone.

Note
If you have assigned your Connect client to Softphone, desk phone option will be displayed.
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Replying to a Voicemail Message
1. Access your voicemail messages as described in Accessing Voicemail Messages on page 68.

2. Click the voicemail that you want to reply to.

3. Click Reply and select any of the following icons:

 to record the message through the telephone.

4. to record the message through the computer microphone.Click  to record your message.

5. Click  to stop recording.

6. Click to play your recorded message.

7. Edit the To and Subject fields as required. While replying to a private voicemail message, you 
cannot add more members to the To field.

8. Specify any desired options (Urgent, Private, Receipt, and Include Original) for sending the 
response.

9. Click Send to send the voicemail, or Cancel to discard the recorded voicemail.

Forwarding a Voicemail Message

1. Access your voicemail messages as described in Accessing Voicemail Messages on page 68.

2. Click the voicemail message that you want to forward.

3. Click Forward and select any of the following icons:

 to record the message through the telephone.

 to record the message through the computer microphone.

4. Click  to record your message.

5. Click  to stop recording.

6. Click  to play your recorded message.

7. Edit the To and Subject fields as required.

Note
You cannot forward private voicemail messages.
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8. Specify any desired options (Urgent, Private and Receipt) for sending the message. 

9. Click Send to forward the voicemail, or Cancel to discard.

Deleting a Voicemail Message
1. Access your voicemail messages as described in Accessing Voicemail Messages on page 68.

2. Do one of the following:

 Right-click the voicemail you want to delete, and select Delete Voicemail.

 Select the voicemail you want to delete and click Delete.

Restoring a Deleted Voicemail Message
1. On the dashboard, click the Voicemails tab.

2. Click  on the Deleted Voicemails header to view the deleted voicemail messages. 

3. Select the voicemail you want to restore.

4. Click Restore.

Configuring Email Notifications for Voicemail Messages

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Notifications.

3. On the second pane, click Voicemail.

4. Select the Send email notification about incoming voicemail to <email address>.

Your email address configured on the Connect Director is displayed.

5. Do the following to customize the email notification:

 To receive the voicemail as .wav file format, select the Attach voicemail as a wave file 
option.

 To mark the voicemail as heard in your voicemail inbox, select the Mark voicemail as heard 
option.

Managing System Notifications for Voicemail Messages

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Notifications.
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3. On the second pane, click Popup.

4. To get a system notification for an incoming voicemail:

 For Windows, select the Show a system notification for a voicemail option.

 For macOS:

1. Under Incoming Voicemail, click Configure via macOS Notification Center...

2. In the Notification Center box, click the Connect Client icon.

3. Click any of the following:

 None
 Banners
 Alerts

Changing your Voicemail Password

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Voicemail.

3. On the second pane, click Setup.

4. Enter:

 Current password
 New password
 Confirm new password

5. Click Set New Password.

Recording Voicemail Greeting Name

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Voicemail.

3. On the second pane, click Setup.

4. Click the Record New Name.

5. Click  to start recording your name, and click  to stop the recording. 

6. Click  to listen to the recorded greeting.

7. Do one of the following:
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 To save the recording, click Save Recording.

 To discard the recorded greeting, click Discard Recording, and repeat steps 4 to 7.

Setting Voicemail Escalation

You can set Voicemail Escalation notification for each new message or the first unheard message, by 
selecting the appropriate option. You can create 9 Voicemail Escalation Profiles. 

1. On the dashboard, click the <username> tab.

2. From the drop down, click Settings and then click Voicemail.

3. On the second pane, click Escalation.

4. Select Add New Profile to create voicemail escalation profiles. 

5. In the Profile Name field, enter a name.

6. Set notification alert frequency using Repeat Times field.

7. In the Add Step section, you can enable the escalation routing notifications for all or urgent only 
voicemail.

 Select Send email notification check box to set email notifications and enter the email 
address in the field, for text only notifications. Select Attach Wave File check box to include a 
.wav file.

 Select Send phone notifications check box to set phone notifications, and enter the phone 
number in the field.

 Set the timeout period to end the notification.

To add additional steps, click Add Step.

Note
Contact your system administrator to activate this feature.

Note
In the Profile Name field a default name appears. However, you can modify or update the field.

Note
If the Send phone notifications check box is selected and the user enters their own DID number, 
an error message “Please do not enter your own office number” is displayed when the user 
clicks the Update/Add button.
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To remove any additional step, click  next to the step.

Assign Voicemail Escalation Profile to Availability State
1. On the dashboard, click the <username> tab.

2. From the drop down, click Settings and then click Call Routing.

3. On the second pane, click Availability Routing.

4. In the When field, click the drop-down list, and select one of the availability states.

5. In the Voicemail Escalation Profile field, click the drop-down list, and select the required profile.

Editing a Voicemail Escalation Profile
You can edit a Voicemail Escalation Profile:

1. On the dashboard, click the <username> tab.

2. From the drop down, click Settings and then click Voicemail.

3. On the second pane, click Escalation.

4. Select the profile from the main list, click Edit.

5. Update the information and click Update to confirm the changes. 

Deleting a Voicemail Escalation Profile
You can delete a Voicemail Escalation Profile to cancel the escalation route.

1. On the dashboard, click the <username> tab.

2. From the drop down, click Settings and then click Voicemail.

3. On the second pane, click Escalation.

4. Select the profile from the main list, click Delete.

Note
Once a voicemail is marked as Heard the escalation process will stop.

If a user sets the voicemail back to Unheard, the escalation process will continue to run until the 
voicemail again goes back to the unheard state.

Note
You can assign a Voicemail Escalation Profile for your availability state except for Do Not 
Disturb state.
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5. In the confirmation dialog box, click Delete.

Playing Envelope Information for Voicemail

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Voicemail.

3. On the second pane, click Playback.

4. Select Play envelope information when listening to messages to hear the received date and 
time of the voicemail. 

The system will announce the date and time when the voicemail was received in the user's inbox 
before playing the message.

Routing Calls
Use the following methods to route incoming calls to your predefined external phones:

 Availability Routing—To assign call routing rules based on availability states
 Power Routing—To set customized rules

Availability Routing
Availability Routing allows you to route incoming calls according to your availability state. 

You can configure Availability Routing with or without Mobility.

Configure Availability Routing with Mobility

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Call Routing.

3. On the second pane, click Availability Routing.

4. In the When field, click the drop-down list, and select one of the availability states.

5. Click the Start Wizard on the right.

6. To specify your Connect Mobility enabled device, do one of the following:

Note
By default, incoming calls are routed to your extension and to your Mobility device.
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 In the blank field, type your 10-digit mobile number.

 If you do not have a mobility device, then click My device with Mitel Mobility will not have a 
number associated with it.

7. Click Next.

The Simultaneous Ring page is displayed.

8. To enable an additional device, other than your extension and a mobility device, to ring 
simultaneously:

a. Enable the Also simultaneously ring these numbers option.

b. Click the Select Number drop-down list.

c. Select the appropriate option, and click Use Selected Number.

9. Click Next.

To configure call forwarding, select one of the following options:

 Select Keep ringing the numbers above.

 Incoming calls will not be forwarded, and only the devices dedicated for simultaneous ringing 
are permitted to ring.

 If you want to forward incoming calls to your voicemail or to another contact, do the following:

1. Select Forward the call to, and click on the drop-down list, and either select my 
voicemail or type in the contact name or the external number, if you have appropriate 
permissions.

2. Click the drop-down list to select the number of rings before forwarding.

3. In the if I have more than 16 active calls forward immediately to field, click the drop-
down list, and either select my voicemail, or type the contact name or the external 
number, if you have appropriate permissions.

 Select the Always forward my calls to option, and click the drop-down list, and either select 
my voicemail or type the contact name or the external number, if you have appropriate 
permissions.

Note
By default, the Simultaneous Ring page displays an extension and a mobility device that are 
already included for simultaneous ring.

Note
If you are not available on any of the devices configured for simultaneous ringing, then you can 
route the incoming calls either to your voicemail or to any other external number with appropriate 
permissions.
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10. Click Next.

The Voicemail Greeting: Recording & Playback page is displayed.

11. To record the voicemail greeting:

a. Click  to start recording your message, and click  to stop the recording.

b. Click  to listen to the recorded greeting for any incoming voicemail messages.

c. Do one of the following:

1. To save the recorded greeting, click Save Recording.

2. To discard the recorded greeting, click Discard Recording.

12. Click Next.

The Interacting with Greeting page is displayed.

13. To enable interaction with the voicemail greeting:

a. Under Are callers allowed to leave a voicemail after hearing your greeting?, select one of 
the following options: 

 Yes, callers can leave a voicemail.
 No, callers will not be able to leave a voicemail.

b. If you want to forward the incoming call to a particular extension, in the If callers press ‘0’ 
while listening to your greeting Forward calls to field, type a contact name or an extension.

14. Click Done.

Configuring Availability Routing without Mobility

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Call Routing.

3. On the second pane, click Availability Routing.

4. Click the Start Wizard.

The Simultaneous Ring page is displayed. 

5. To enable simultaneous ring for an additional device, do the following:

Note
By default, the Simultaneous Ring page displays the device that is already configured for 
simultaneous ring. 
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a. Select the Also simultaneously ring these numbers option.

b. Click the Select Number drop-down list.

c. Select the additional number, and click Use Selected Number.

6. Click Next.

7. To configure call forwarding, select one of the following options:

 If you do not want to forward incoming calls, select Keep ringing the number above so that 
the devices dedicated for simultaneous ringing are only permitted to ring.

 If you want to forward incoming calls to your voicemail, do the following:

1. Select Forward the call to and click on the down arrow icon, and select my voicemail.

2. Click the drop-down list to select a number for the rings before forwarding.

3. In the if I have more than X active calls forward immediately to field, click the down 
arrow icon, and select my voicemail.

 Select the Always forward my calls to option, click the drop-down list, and select my 
voicemail.

8. Click Next.

9. To enable FindMe, do the following:

a. Select Enabled: Use my FindMe settings to continue routing the call.

b. Select any one of the following options:

 Select Ring my FindMe numbers sequentially before playing my voicemail, and 
optionally select Prompt the caller to record their name.

 Select Play my voicemail first. If the caller presses 1 during the greeting then 
sequentially ring my FindMe numbers, and check Prompt the caller to record their 
name.

c. To define FindMe numbers that will be used sequentially, click the Select Number drop-down 
list, select the appropriate option and click Use Selected Number.

d. To add another FindMe number, repeat step 8c.

10. Click Next.

The Voicemail Greeting: Recording & Playback page is displayed.

11. To enable voicemail greeting, see To record the voicemail greeting: on page 77.

Note
If the FindMe option is not displayed, contact your Administrator to enable the “Allow external call 
forwarding and find me destination” option on the Connect Director.
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12. Click Next.

The Interacting with Greeting page is displayed.

13. To enable interacting with the voicemail greeting, see To enable interaction with the voicemail 
greeting: on page 77.

Configuring Availability Routing Using Custom Settings

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Call Routing.

3. On the second pane, click Availability Routing.

4. To configure a mobility device for incoming calls, see To specify your Connect Mobility enabled 
device, do one of the following: on page 75.

5. Click Change/Record to configure the following options, as required:

 Incoming calls are routed to your Deskphone. 

 No phones selected to simultaneously ring. To configure this option:

 For simultaneous ring with mobility enabled, see step 8 in Configure Availability Routing with 
Mobility on page 75. 

 For simultaneous ring without mobility enabled, see step 5 in Configuring Availability Routing 
without Mobility on page 77. 

 Number of rings before incoming calls are routed to voicemail. To configure this option: 

 For incoming call forwarding with mobility enabled, see step 9 in Configure Availability Routing 
with Mobility on page 75. 

 For incoming call forwarding without mobility enabled, see step 7 in Configuring Availability 
Routing without Mobility on page 77.

 If callers press 1 while listening to my voicemail greeting, no phones are selected to 
sequentially ring. To configure this option, see step 9 in Configuring Availability Routing without 
Mobility on page 77.

 No voicemail greeting recorded. To configure this option, see To record the voicemail greeting: 
on page 77.

 Callers are allowed to leave a voicemail. To configure this option, see To enable interaction with 
the voicemail greeting: on page 77.

 Callers who press 0 during the voicemail greeting will be forwarded to the Auto- Attendant. 
To configure this option, see To enable interaction with the voicemail greeting: on page 77.
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Using Power Routing
Power Routing allows you to create customized personal rules for call routing. You can also edit and 
delete your power routing rules.

Power Routing overrides Availability Routing.

Creating a Power Routing Rule

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Call Routing.

3. On the second pane, click Power Routing.

4. Click Create New Power Rule.

5. In the Rule Name field, enter a <name> for the new power rule.

6. In the When field, choose a combination of the following conditions to build a custom file for when 
to forward a call:

 + number matches
 + dialed number
 + my availability
 + on the phone
 + time is

7. To add a rule by matching a number:

a. Click + number matches.

b. Click the The number is drop-down list, and select a suitable option. (For a few of these 
options, you might have to enter an associated number in the corresponding field.)

c. To create another rule, repeat steps 7a to 7b.

8. To add a rule based on the known dialed number:

a. Click + dialed number.

b. Click inside the Number caller dialed to reach me is field, and type in the known number.

9. To add a rule based on your availability:

a. Click + my availability.
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b. Select one of the availability states:

 Available
 In a Meeting
 Out of Office
 Vacation
 Custom
 DND

10. To add a rule if you are already on a phone, click + on the phone.

11. To add a rule based on the time or on the day:

a. Click + time is.

b. Select either of the following:

 If Time is selected, enter the From and To fields for the power rule.
 If Day is selected, select the days for the power rule.

12. Under Then, click Forward call to and select any of the following options:

 To forward the call to voicemail, select the my voicemail option.

 To play a ring tone:

 Click the my voicemail drop-down list and select play ringtone. An additional Standard 
Ring option is displayed.

 Click on the drop-down list and select a ring tone option.

 To forward the call to specific number, select the Select Number option and click in the Select 
Number field and type the desired number.

13. Click Create Rule.

Modifying a Power Routing Rule

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Call Routing.

3. On the second pane, click Power Routing.

4. For the power rule you want to edit, click Edit.

5. Edit the steps as required. (For more information, see steps 6 to 12 of Creating a Power Routing 
Rule on page 80.)

6. Click Save Rule.
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Deleting a Power Routing Rule

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Call Routing.

3. On the second pane, click Power Routing.

4. Click Delete for the power rule you want to delete.

Routing Calls to Mobile
You can route all your incoming calls to your Mobility device. You can select or enter the mobile 
number on which you have installed the Connect Mobility.

To enable this feature, your Connect administrator must configure the Enable Enhanced Mobility with 
Extension feature in the Connect Director.

Customizing your Call Option Settings

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Telephony.

3. On the second pane, click the Maximum number of concurrent calls drop-down list, and select 
a number in the range configured by your Connect administrator.

4. If you want to suppress call waiting tone, select Suppress call waiting tone when I’m on a call.

5. If you want to suppress dial tone, select Suppress dial tone when I’m off-hook in headset 
mode on an analog phone.

6. If you want to close contact card, select Close contact card after call ends option to close the 
contact card soon after you end the call.



CHAPTER

7

Connect client User Guide 83

7. Managing Messages

This chapter provides information about managing messages.

Sending a Message ..................................................................................................  84
Viewing Direct Conversation History with a Contact...........................................  85
Scheduling a Meeting with a Contact Group ......................................................  85

Managing Canned Response....................................................................................  85
Adding Canned Message Responses ................................................................  87
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Sending a Message
The Teamwork for Desktop application is packaged with the Connect Client application to provide 
Connect Client users a seamless cross-launching messaging experience between Connect Client and 
Teamwork for Desktop application.

MiCloud Connect users can send messages to:

 Individuals
 Multiple users
 Groups

 MiCloud Connect Users:

Figure 6:  Contact Card with message icon

For MiCloud Connect user, the Connect Client sends messages through Teamwork for Desktop.

To send a message to an individual contact:

1. Do either of the following to find the contact:

 Search for the contact by typing the name or the extension number and select the 
contact.

 On the dashboard, click Contacts and select the contact from your Favorites list.

2. Do either of the following to send a message:

 On the contact card, click .

 From the Search results bar or from the Favorites list, right-click the contact, and 
select Send IM.

The Conversation launches through the Teamwork for Desktop application. If you already 
have a conversation history with the contact, the Teamwork for Desktop opens the existing 
message conversation; otherwise, it starts a new conversation under the Direct Message 
tab.

3. In the message input box, type the message, and press Enter.

Click the emoticon in the message input box, and select the emoticon to add it to your 
message.
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To send a message to a group:

1. On the dashboard, click Contacts > Groups, and select the group.

2. Click . The group contact card opens in the third pane.

3. Click Start Chat. The conversation launches on the Teamwork for Desktop application. 
The application opens the existing group-chat- if there is one, or else creates a new group 
chat under the Direct Message tab.

4. In the message input box, type the message, and press Enter.

Click the emoticon in the message input box, and select the emoticon to add it to your message.

For more details about using Teamwork for Web and Desktop, see https://oneview.mitel.com/s/
article/Mitel-Teamwork-for-Web-and-Desktop.

Viewing Direct Conversation History with a Contact
1. Search for the contact by typing the name or the extension number of the contact in the 

Quick Dialer Search bar, and select the contact.

2. In the third pane, click . The message conversation history is displayed in the 

Teamwork for Desktop application.

The message conversation list appears on the left panel of the Teamwork for Desktop application 
after the first message is sent. To view the conversation history for a contact, click the contact 
under the Direct Message tab. The conversation history for that contact opens in the chat pane.

Scheduling a Meeting with a Contact Group
1. On the dashboard, click the Contacts tab.

2. Click the Groups tab, and select a group.

3. Click  on the group header and click Schedule Meeting.

4. Specify the details of the meeting.

5. Click Create.

Managing Canned Response
You can create a canned message for responding to an incoming call.

To create a canned response:

https://oneview.mitel.com/s/article/Mitel-Teamwork-for-Web-and-Desktop
https://oneview.mitel.com/s/article/Mitel-Teamwork-for-Web-and-Desktop
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1. Launch the Mitel Connect client.

The dashboard is displayed.

2. Click the <username> tab.

The username page is displayed on the middle pane.

3. Click Preferences > IM > Canned IM Responses.

The canned IM response screen is displayed.

4. In the blank field and type the canned message, and click Add Canned Response.

The canned message is saved in the box located below.

You have successfully added a canned response.

To delete a canned response:

1. Launch the Mitel Connect client.

The dashboard is displayed.

2. Click the <username> tab.

The username page is displayed on the middle pane.

3. Click Preferences > IM > Canned IM Responses.

The canned IM responses are listed in the box.

4. Select a canned response, and click Delete.

You have successfully deleted a canned response.
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Adding Canned Message Responses
Canned IM response allows you to respond to an incoming call with an IM message that is predefined 
in the Connect Client application. If you are unable to respond to an incoming call in person, you can 
send a Canned IM response to the contact. 

To add a canned IM response:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click IM.

3. On the second pane, click IM Responses.

4. Type your custom canned message, and click Add Canned Response.

5. Select the required canned messages from the text box, and click Delete to delete the canned 
message.

Note
Canned messages sent by the MiCloud Connect users from Connect Client are received in the 
Teamwork for Desktop application.
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8. Integrating with Microsoft
Exchange/Office 365

This chapter provides information about integrating the Connect client with Microsoft Exchange/Office 
365:

Integrating the Connect client with Microsoft Exchange/Office 365 ..........................89
Synchronizing Meetings with Microsoft Outlook or Office 365 Calendar ............91
Synchronizing the Connect client with Microsoft Outlook or Office 365 Contact 
Folders ................................................................................................................92
Understanding the Presence Status in Microsoft Outlook ..................................93
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Integrating the Connect client with Microsoft 
Exchange/Office 365

The Connect client is now integrated with Microsoft Exchange. 

Integrate the Connect client with Microsoft Exchange to use the following client features:

 Synchronize meetings and availability status with the Outlook or Office 365 calendar.

 Synchronize your Outlook or Office 365 contact folders with the Connect client for Windows. For 
macOS, the Connect client synchronizes with the Mac Address book. (For more information about 
synchronizing the Connect client with Mac Address book, refer to Importing the Contact Folders on 
page 31.

You can integrate Connect Client with Exchange/Office 365 in two ways:

1. From the Meetings tab

2. From the Settings tab

To integrate Connect Client with Exchange/Office 365 from the Meetings tab

1. On the dashboard, click the Meetings tab. 

2. If you are an Office 365 user and using an Office 365 Authentication (Modern Auth) version of the 
Connect Client, a Microsoft OAuth page appears, which captures your credentials.

3. If you are a non-Office 365 user or using a non- Modern Auth version of the Connect Client,

a. An Exchange Credentials dialog appears.

Note
If a sign in dialog appears, enter your Office 365 credentials.

I
f

Note
If you see an error message in the dashboard as shown, contact your IT Admin or Office 365 
Admin to enable Modern Auth in Mitel admin portal.
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b. Enter your user name and password, and then click Submit.

To integrate Connect Client with Exchange/Office 365 from Settings tab:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Accounts.

3. On the second pane, click Exchange Account.

The Exchange Account tab does not appear if your Connect Client user name and email address 
are the same (for premise customers). For more details about signing in to the Connect client, 
refer to Signing in to the Connect Client on page 15.

4. Click Link Exchange Account.

5. If you are an Office 365 user and using a Modern Auth version of the Connect Client, a Microsoft 
OAuth page appears, which captures your credentials.

6. If you are a non-Office 365 user or using a non-Modern Auth version of the Connect Client,

a. An Exchange Credentials dialog appears.

Note
If you enter an invalid credential, an error as shown is displayed.

Note
If a sign in dialog appears, enter your Office 365 credentials.

I
f

Note
If you see an error message as shown, contact your IT Admin or Office 365 Admin to enable 
Modern Auth in Mitel admin portal.
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b. Enter your user name and password, and then click Submit.

Upon successful credentials validation, the Unlink Mitel Connect from Exchange option is displayed.

To disable integration with Exchange server, click Unlink Mitel Connect from Exchange. Restart the 
Connect client for the changes to take effect.

Synchronizing Meetings with Microsoft Outlook or Office 365 
Calendar

After integrating the Connect client with Office 365:

 Your Outlook appointments and Connect client meetings are displayed on both the Outlook 
calendar and the Meetings tab.

 When you create an event on Connect client, a meeting invite with the conference details is 
displayed in Outlook which can be sent to the participants. For more information about creating an 
event on Connect client, refer to Creating a Conference on page 96.

Note
If you enter an invalid credential, an error as shown is displayed.

Note
Outlook for Mac versions 16.16 and prior work as expected, but newer version have these limitations.

1. After creating an event, it cannot be edited in the Connect client, but can be edited in Outlook. 
2. When creating an event, because the date and time may be incorrect, you need to review the date 

and time in Outlook before sending the event. 
3. When creating an event, because the attendee list is not transferred to Outlook, but is copied to the 

clipboard, you should paste the attendee list in Outlook.

Note
On a Windows machine, you can enable a delegate to access your Outlook calendar and perform the 
following actions on your calendar via Connect Outlook Add-In.

 Create new Connect conferences.
 Edit existing Connect conferences. 
 Delete existing Connect conferences.
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You can synchronize the availability state between the Connect client and the Outlook or Office 365 
calendar. For example, if you have a meeting currently scheduled on Outlook calendar, your 
availability state on Connect client changes to “In a meeting”. However, you can also manually change 
your availability state on the Connect client.

To synchronize your availability state on the Connect client with the Outlook or Office 365 calendar:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then; 

 for macOS, click Contacts/Outlook.

 for Windows, click Outlook.

3. Select the Sync my Exchange calendar with my Mitel Connect availability modes check box.

 Your availability state on the Connect client changes based on your schedule on the Outlook 
or Office 365 calendar. 

 The Do Not Disturb, the Vacation, and the Custom availability states always take precedence 
and do not get affected by this setting.

4. Select the Use my Outlook Work Hours to switch my Mitel Connect availability to Out of 
Office option to change your availability state to Out of Office based on your work hours and days 
specified on your Microsoft Outlook or Office 365 calendar.

You must restart the Connect client for any changes to take effect.

For information about setting the work hours and days on Outlook calendar, refer to the Microsoft 
Outlook documentation.

Synchronizing the Connect client with Microsoft Outlook or 
Office 365 Contact Folders

When you sign in to the Connect Client while Outlook is closed, you may see some type of Outlook 
prompt.

After integrating the Connect client with Office 365, Windows users only can do the following to import 
the contact folders from Microsoft Outlook into the Connect client to make calls or send messages:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then and then click Outlook.

3. Select the Sync my Outlook contacts option.

Note
For Windows, the “ConnectUCBAddIn” add-in should be enabled on your Outlook to complete 
this synchronization. For more information about enabling Add-ins in Outlook, refer to 
Microsoft Outlook documentation.
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4. Click +Show contact folders and select the folders that you want to synchronize with the Connect 
client. 

You can also import the Outlook contact folders shared by other users into your Connect client. For 
the shared contact folders to appear in +Show contact folders, open the shared invitation email 
and click Open this Contacts folder. For more details about sharing a contact folder in Outlook, 
refer to Microsoft Outlook documentation.

For macOS, you can synchronize the Connect client with the Mac address book. For information about 
synchronizing the Connect client with Mac address book, refer to Importing the Contact Folders on 
page 31.

You can search for contacts from your Microsoft Outlook Public folders, but you cannot import contacts 
from Public folders to Connect client.

To enable searching for the contact from the Exchange Public Contact folders:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then; 

 for macOS, click Contacts/Outlook.

 for Windows, click Outlook.

3. Select the Enable searching for contacts in my exchange public contact folders check box.

You can view the contacts from your Exchange Public folders in the Connect client directory.

Understanding the Presence Status in Microsoft Outlook
Microsoft Outlook displays the presence status of a contact beside the contact’s name. For Mitel 
system users, the presence status indicates the availability status of a contact as configured by the 
user. (See Understanding Availability States on page 37.)

If Outlook is not synchronized, incorrect or no presence status information might be shown.

For any issues related to Outlook synchronization, contact your system administrator and ensure that 
in Mitel Connect Director:

 The Outlook email address and the Mitel system email address are the same.

 The IM functionality is enabled for the user.
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9. Managing Conferences

This chapter provides information about how to create and manage Connect conferences.
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Creating a Conference
1. On the dashboard, click the Meetings tab. 

2. Click  icon at the top right corner of the second pane.

3. In the Name field, enter a name for the conference. This name is used in email notifications about 
the conference.

4. In the Starts fields, enter the date, and the start time of the conference.

5. In the Meeting Lasts field, enter the duration of the meeting in hours and minutes.

6. From the Occurs drop-down list, select the recurring frequency of the conference. 

7. In the On Site Location field, enter the venue for the conference.

Alternatively, check the Use my own bridge option to use the reservation-less conference bridge. 
Select the conference bridge of your choice from the drop-down list. For more information, click 

 next to Use my own bridge.

8. In the Organizers field, enter the names of the people hosting the conference. 

9. In the Presenters field, enter the names of people presenting during the conference. 

Check the option below the Presenters field, to add additional participants, external contacts who 
require approval from the meeting organizer to share their screen. 

For more information, about adding Presenters and Participants click  respectively.

10. In the Agenda field, enter the name of the agenda and the duration of the agenda in minutes.

11. In the Overview field, enter a brief description of the purpose of the conference.

12. To attach any reference material for the participants, click Choose from Dropbox in the Files 
section. To attach files, you must sign in to Dropbox with your credentials.

Note
You see the Occurs field only if you have not integrated the Connect client with Microsoft 
Exchange.

Note
You see the Use my own bridge option only if you have reservation-less conference and 
integrated the Connect client with Microsoft Exchange.

Note
You can drag and drop contacts to shift them between the Organizers, Presenters, and 
Participants fields.



Creating a Conference Managing Conferences 9

Connect Client User Guide 97

13. In the More Settings section:

a. To set a customized access code, user can select Custom Access Code option.

b. To set a password, select the Protect Meeting with Password option, and enter the 
password in the Password field.

c. In the Start the Meeting section, choose one of the following options:

 When anyone joins
 When one of the organizers joins

d. In the Participants section:

 To announce the arrival of a participant on the conference call, select the Announce 
when participants arrive option, and select one of the following options:

 Play a simple audio tone
 Prompt participants to record their name, and announce when they try to join and 

leave the meeting

 To mute all participants joining the conference call, select the Mute participants on entry 
option.

 To display the names of all participants who have joined the conference, select the Show 
everyone’s name to all participants option.

 In the When dialing out to participants area, select one of the following options: 

 Must press one to enter audio portion of the meeting
 Participants are automatically added to the audio portion of the meeting

14. Click Create to generate the invite.

15. Depending on your configuration, you see one of the following results:

 If the Connect client is successfully integrated with Microsoft Exchange, you see a Create 
Conference Success Opening Outlook Please Wait message. An email invite draft is 
opened in Microsoft Outlook, where you can review the content, set reminders and recurrence, 

Note
If the Choose from Dropbox tab is disabled for on-site users, you cannot add new files from 
the Dropbox.

To enable the Choose from Dropbox feature, contact the system administrator.

Note
The Participant Code and the Organizer Code are automatically generated. Optionally, you 
can set the Participant and Organizer Code using settings in the D2 UCB.
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and review the list of participants before sending the invite. If you do not see this invite, see 
Chapter 8, Integrating with Microsoft Exchange/Office 365 on page 88 for information about 
integration.

 If you have not integrated the Connect client with Microsoft Exchange, the new event is 
created and displayed with the Connect assigned details as described in Table 4 on page 98. 
When you click Meetings on the dashboard, the conference is listed on the Upcoming tab in 
the second pane. 

Editing a Conference
As an organizer, you can edit a conference.

To edit a conference, do the following:

1. On the dashboard, click the Meetings tab.

2. Click the Upcoming tab to view all the upcoming conferences. 

3. Select the conference.

4. Click .

5. Edit the conference details in the required fields, and click Save.

Table 4:  Connect Conference Details 

Conference Detail Description

ID The meeting ID that is automatically generated by the Connect 
system when an event is created

Dial-in Info The conference call dial-in info for host and participants

<Web Conference link for 
leader/host>

Connect Conference web page link for the host

Participant Code The access code for participants to join the conference call

<Web Conference link for 
participants>

Connect Conference web page link for participants

Password (optional) The password to join the secure conference call

Additional Calling Info The dial-in info for different regions. This information is fetched 
from the Connect Director. To update this information, contact 
your Connect administrator.
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Creating a Conference from Microsoft Outlook
1. Launch Microsoft Outlook.

2. Click New Items > Meeting.

3. Click the conference icon at the top right corner of the Outlook ribbon.

A Connect conference is automatically generated with the details listed in Table 4 on page 98 
appended to the email invite.

4. In the To field, enter the list of participants to invite to the conference. Click Address Book or 
Check Names to select or identify directory contacts.

5. To assign participant’s role:

a. Click Conference > Settings to open the conference settings window.

b. Un-check Collaborative meeting - everyone can present field.

c. Click the drop-down next to the presenter’s name and select the required role.

d. Click OK to save.

6. In the Subject field, enter the purpose of the conference.

7. In the Location field, enter the venue of the conference.

8. In the Start time fields, enter the date and start time of the conference.

9. In the End time fields, enter the date and end time of the conference.

10. Click Response Options to configure the responses received from the participants.

11. Select the time slot from the Reminder drop-down list to set a reminder.

12. Click Recurrence if you want the conference to occur more than once.

13. Click the Available Outlook option to configure any other preferences.

14. Click Send.

Creating a Reservation-less Conference

You can start a conference directly from the second pane on the Connect client without scheduling the 
conference in advance. This is called a reservation-less conference.You can also invite other users to 
join these conferences.

To invite participants to a conference:

Note
You must have Outlook configured with the Connect client before creating a reservation-less 
conference. The event invite can be shared only using Outlook.



100 User Guide Connect Client

Managing Conferences Adding a new Reservation-less Conference9

1. On the dashboard, click  or the <username> tab.

2. Click the arrow next to the conference bridge name and do one of the following:

 To dial into the conference, click .

 To share the screen or send an IM without joining the conference, click . You can also dial 
into the conference or configure a call back from here.

 Open the Link provided in the conference bridge in a web browser.

 Refer to Additional Calling Info to use the region specific toll free dial in info.

3. To invite participants to join your conference, do one of the following:

 Click Copy to copy the conference information, and share the information with other users you 
want to invite.

 After launching the conference, click  and type the participant’s name you want to invite 
and then click Conference. 

4. To drop a participant, on the dashboard:

a. Click  icon below the participant name.

b. In the confirmation dialog box, click Yes.

Adding a new Reservation-less Conference
You can use the My Conference section to add a reservation-less conference. To add a new 
conference bridge:

1. On the second pane, click Add New Conference Bridge.

2. In the Add New Conference Bridge pop-up window:

 Enter the name of the conference in the Name field.

3. In the More Settings section:

 Set a password for the conference, by enabling the Protect Meeting with Password option, 
and entering a password

Note
The Participant Code and the Organizer Code are automatically generated. Optionally, you 
can set the Participant and Organizer Code using settings in the D2 UCB.
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 In the Start the Meeting section, you can only use the default “When anyone joins” setting. 
The “When one of the organizers joins” setting cannot be selected for a reservation-less 
conference.

 In the Participants section:

 To announce the arrival of a participant on the conference call, select the Announce 
when participants arrive option, and select one of the following options:

 Play a simple audio tone
 Prompt participants to record their name and announce when they try to join and leave 

the meeting
 To mute all participants joining the conference call, select the Mute Participants on entry 

option.
 To display the names of all participants who have joined the conference, select the Show 

everyone’s name to all participants option.

 In the When dialing out to participants section, select one of the following options: 

 Must press one to enter audio portion of the meeting
 Participants are automatically added to the audio portion of the meeting

4. Click Add.

Editing a Reservation-less Conference
From the Edit, a user can remove or update a reservation-less conference bridge. Click Remove to 
delete a conference bridge. 

To update a reservation-less conference bridge:

1. On the second pane, click the drop down next to the selected conference bridge name and click 
Edit.

2. Edit the name of the conference bridge in the Name field, and you can do the following in the More 
Settings section:

 Set a password for the conference, by enabling the Protect Meeting with Password option, 
and entering a password.

 Select the required options from Participants section and the When dialing out to 
participants section respectively. 

3. Click Update to save the changes.
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Migrating Reservation-less Conferences from ST 
Communicator

Reservation-less conferences migrate from ST Communicator to the Connect client as follows:

 Users who have a reservation-less conference that was previously configured in ST 
Communicator and who are unassigned to a service appliance will get an error message when 
trying to create a new event or if they try to join to an existing conference in the Connect client. To 
remove these conferences from the Connect client, users should manually delete the old 
conferences from Outlook Calendar.

 Users who have a reservation-less conference that was previously configured in ST 
Communicator and who are assigned to a service appliance will have a reservation-less 
conference created during migration, and the settings defined previously remain valid.

While participant codes on a migrated reservation-less conference remain valid, the When dialing 
out to participants parameter in the event screen is always set to Must press one to enter 
audio portion of the meeting regardless of whether the conference was previously configured 
with Participants are automatically added to the audio portion of the meeting.

 Users who do not have a reservation-less conference previously configured in ST Communicator 
and who are not assigned to a service appliance will not have a reservation-less conference 
created during migration.

Accessing Recordings Made with ST Communicator

Prior to migrating from ST Communicator to the Connect client, download any recordings made with 
ST Communicator and save them to your local system. While the downloaded recordings cannot be 
played in the Connect client, you can use a Flash player to play them.

Viewing Conferences
1. On the dashboard, click the Meetings tab.

2. Click Upcoming to view the list of future conference, and click Past to the list of conference in the 
past.

The list is sorted by date, from the most recent to the oldest. 

You can filter past meetings to display only the Recorded meetings. To filter, click in the Past 
tab and select Recorded Only. 

Note

 If users have multiple reservation-less conferences configured in ST Communicator, all the 
reservation-less conferences are migrated.

 Reservation-less conferences can be edited or changed after migration.
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To view the meetings of a specific date, click on the second pane and select the date. The 

meetings for the selected date will display at the top of the second pane.

Downloading the iCalendar Data (ICS) File for a 
Conference

The Connect client generates an ICS file for every event. The Connect client uses the generated ICS 
file to send a meeting invite if Microsoft Exchange is not deployed. All participants can use this ICS file 
to populate their calendars with the meeting invite.

To download the Conference iCalendar data file:

1. On the dashboard, click the Meetings tab.

2. Click the Upcoming tab to view all upcoming conferences. 

3. Select the conference in the second pane to download the ICS file.

4. Click .

The Save As dialog box is displayed. The default file name is shoretel.ics, and the default 
path for saving the file is C:\Users\<user>\AppData\Local\ShoreTel\events.

5. Enter the file name and select the location or accept the default, and click Save.

6. Locate the file on your computer, and double-click to open the iCalendar file.

7. Review all the information about the conference, and save to your calendar.

Joining a Conference
You can join a conference from the Connect client in the following ways:

 Joining a Conference from the Dashboard: Use this procedure if you see a notification for the 
upcoming conference in the notification area on the dashboard. The notification is usually sent 5 
minutes prior to a conference. 

 Joining a Conference from the Meetings Tab: Use this procedure to join the conference from the 
Meetings tab.

Note
If you have integrated the Connect client with Microsoft Exchange, you see all your conferences in 
your Outlook calendar.
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 Joining a Conference from Your Calendar: Use this procedure to join the conference from your 
calendar.

 Joining a Conference from an iOS Device: Use this procedure to join the conference from your iOS 
device.

Figure 7 describes the different ways to join a conference.

Figure 7:  Joining a Conference

Joining a Conference from the Dashboard
When you see an event notification on the dashboard, do one of the following to join:

 To configure a call back:

a. Click the drop-down icon in beside the event name.

b. In the Call me at field, enter your phone number. Optionally, you can skip this step if you have 
configured a call back in the previous conference and you want to use the same number (the 
previous number is saved in the Call Me field).

c. Click Call Me.
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 To dial into the conference, click the call icon in beside the event name.

 If you have assigned a softphone to the Connect client, you see a notification on the 
dashboard when you are connected.

 If you have assigned a desk phone or an external number to the Connect client, the assigned 
phone rings.

If you are unable to dial into the conference through the assigned phone, see Chapter 5, Managing 
Phones on page 42.

 To share the screen or send an IM without joining the conference, click . You can also dial into 
the conference or configure a call back from here.

If you have joined the screen share, click  on the task bar at the bottom of the second pane 

and do one of the following to dial into the conference:

 To join the conference through the assigned phone (softphone or desk phone), click Call via 
<assigned phone>. If you have assigned any external number, click Call External 
Assignment.

 To configure a call back, in the Call me at field enter your phone number, and click Call Me.

To end the conference, click .

Joining a Conference from the Meetings Tab
1. On the dashboard, click the Meetings tab.

2. To view all upcoming conferences, click the Upcoming tab. 

3. Select the conference that you want to join and do one of the following:

 To configure a call back:

1. Click the drop-down icon in  beside the event name.

2. In the Call me at field, enter your phone number. Optionally, you can skip this step if you 
have configured a call back in the previous conference and you want to use the same 
number (the previous number is saved in the Call Me field).

3. Click Call Me.

 To dial into the conference, click beside the event name.

 If you have assigned a softphone to the Connect client, you see a notification on the 
dashboard when you are connected.
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 If you have assigned a desk phone or an external number to the Connect client, the 
assigned phone rings.

If you are unable to dial into the conference through the assigned phone, see Chapter 5, 
Managing Phones on page 42.

 To share the screen or send an IM without joining the conference, click . You can also dial 
into the conference or configure a call back from here.

If you have joined the screen share, click  on the task bar at the bottom of the second pane 

and do one of the following to dial into the conference:

 To join the conference through the assigned phone (softphone or desk phone), click Call via 
<assigned phone>. If you have assigned any external number, click Call External 
Assignment.

 To configure a call back, in the Call me at field enter your phone number, and click Call Me.

To end the conference, click .

Joining a Conference from Your Calendar
If you have successfully integrated the Connect client with Microsoft Exchange or have downloaded 
and added the iCalendar data file to your personal calendar, you can join a conference by opening the 
appointment on your calendar.

1. Open your calendar.

2. Open the conference invitation.

The invitation contains the details of the conference, as described in Table 4 on page 98.

3. Do one of the following:

 Click the Click Here to Join link.

 Open the URL provided in the conference invitation on a web browser.

4. In the Introduce yourself as field, enter your name and press Enter.

5. Click on the task bar at the bottom of the page, and do one of the following:

 To join the conference through the computer audio, click Call via Computer Audio. 
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 To configure a call back, in the Call me at field enter your phone number, and click Call Me.

6. You can perform the following actions during the conference using the icons on the task bar at the 
bottom of the page:

 To leave the call during the conference, click .

 To mute and unmute your audio during the call, click .

 To share your screen, a portion of the screen, or an application window, click .

 To view and copy the meeting information, click .

 To ask a question during the conference, click .

7. After the conference ends, close the browser to leave the conference.

Optionally, you can use the dial-in info and the participant code given in the conference invitation to 
join the conference through your cell phone.

Joining a Conference from an iOS Device
To join a web conference from an iOS device, do either of the following:

 If the Mitel Connect application is installed on your iOS device, all the Outlook meetings are 
displayed.

1. Open Mitel Connect.

2. Open the Conference invitation to display details of the conference.

3. Tap Join Audio to join the audio bridge or Join Web Bridge to open the conference in a 
web browser.

4. In the Introduce yourself as field, enter your name.

5. In the Call me at (optional) field, enter your number.

6. Tap Join to join the conference.

 If the Mitel Connect application is not installed on your iOS device.

1. Do one of the following on your iOS device:

Note

 You can configure a call back only after the organizer joins the conference. If the organizer 
has not joined the conference, the Call Me option is disabled, and you see the message, 
Available after an organizer joins below the Call Me field.

 Call via Computer Audio is not supported in the Safari 12.0 browser.
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 Open your calendar and tap the meeting URL you want to join. The web portion of the 
conference opens in the Connect web collaboration client launched through the Safari 
browser.

 Open the Safari browser and enter the meeting URL. The web portion of the 
conference opens in the Connect web collaboration client launched through the 
browser.

2. In the Introduce yourself as field, enter your name.

3. In the Call me at (optional) field, enter your number.

4. Tap Join to join the conference.

After the conference ends, close the browser to leave the conference. 

Placing a Participant on Mute
If you are an organizer of the conference, you can mute and unmute all participants or an individual 
participant.

 To mute all participants, click  icon on the conference task bar.

 To unmute all participants, click icon on the conference task bar.

 To mute a participant, click icon beside the participant name on the dashboard.

 To unmute a participant, click icon beside the participant name on the dashboard.

Note

 If you have not entered your call back number at the beginning, you can refresh the browser to 
navigate to the starting page and enter the number.

 Softphone, Agenda, screen sharing and individual chat are not supported for conferences on an 
iOS device.

Note
If you enable the Mute participants on entry option while creating the conference, the Mute-all 
option is automatically enabled and all the participants will be on mute when they join the conference. 
For more information about creating a conference, refer to Creating a Conference on page 96.
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Dropping a Participant from Conference
Organizer can drop a participant from the conference.

To drop a participant, do one of the following on the dashboard:

 Click icon below the participant name. In the confirmation dialog box, click Yes.

 Right-click the contact and select Remove <user name>.

Recording a Conference
1. Dial in to join a conference.

2. Click  on the conference task bar to start recording the conference.

The REC icon turns red to indicate that recording is in progress.

3. When you want to stop recording, click .

You can stop a recording while a conference is in progress. To leave the conference, you must 
click the red call end icon as explained in Joining a Conference on page 103.

You can download, play or copy the recording URL.

1. On the dashboard, click Meetings > Past.

The conference with recordings are indicated with .

2. In the second pane, select the conference.

3. In the third pane, click  and select the required option.

Notes

 You can play the conference recordings on the Connect client and all web browsers except the 
Microsoft Internet Explorer 11.

 If you do not find your recordings in the Past tab or if you do not have access to the Connect Client 
application, contact Mitel Support and request the required recording.
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Canceling a Conference
You can cancel a Connect conference any time through either the Connect client or Microsoft Outlook.

Canceling a Conference from the Connect client
1. Click the Meetings tab on the dashboard.

2. Click the Upcoming tab to view the list of future conferences.

The list is sorted by date, from the current event to future meetings.

3. Click the conference that you want to cancel.

4. Click Cancel Event at the bottom of the third pane.

5. Click Cancel in the confirmation dialog box.

The Canceling Event message is displayed at the bottom of the third pane. This message is 
followed by Opening Outlook Please Wait message, and the Outlook invite is launched (if you 
have integrated with Microsoft Exchange). 

6. Click Send Cancellation in the Outlook invite cancellation window to notify participants of the 
cancellation.

Canceling a Conference from Microsoft Outlook
If you have integrated the Connect client with Microsoft Outlook, you can cancel a conference from the 
Outlook client.

1. Launch Microsoft Outlook.

2. Open the conference appointment in the Outlook calendar.

3. Click Cancel Meeting at the top left corner of the Outlook ribbon.

4. Click Send Cancellation to notify participants of the cancellation.
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Conferencing using Connect client for Web
You can use the Connect client for Web to launch Connect conferencing without the Connect client. 
This feature is useful for remote users who have not installed the client on their systems.

By using the Connect client for Web, you can join a Connect conference from any non-Mitel network 
without entering any authentication details. Organizers joining the conference through the Connect 
client for Web can only serve as participants, not presenters or organizers in the meeting. 

Using the Connect client for Web
1. Do one of the following in the meeting invite sent by the conference host:

 Open the Link in a web browser.

 Click the Click here to join link.

2. In the Introduce yourself as field, enter your name, and press Enter.

The navigation pane on the left displays:

 Meeting Title—the conference name

 Now Sharing—the contact currently sharing the screen

 Now Speaking—the contact currently speaking in the conference

 Group Chat—public chat window for all conference participants

 Attendees—list of participants in the conference

3. Click on the task bar at the bottom of the page, and do one of the following:

 To join the conference through the computer audio, click Call via Computer Audio. 

 To configure a call back, enter the number in the Call Me field, and click Call Me.

Note
You can configure a call back only after the organizer joins the conference. If the organizer has 
not joined the conference, the Call Me option is disabled, and you see the message, Available 
after an organizer joins below the Call Me field.
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4. You can perform the following actions during the conference using the icons on the task bar at the 
bottom of the page:

 To leave the call during the conference, click .

 To mute and unmute your audio during the call, click .

 To share your screen, a portion of the screen, or an application window, click .

 To view and copy the meeting information, click .

 To ask a question during the conference, click .

5. After the conference ends, close the browser to leave the conference.

Optionally, you can use the dial-in info and the participant code given in the conference invitation to 
join the conference through your cell phone.

Using Group Chat
Messages from other users are indicated with a red pop-up. Click the group chat window or a 
participant’s name to view the message.

To send a message to the conference participants:

1. Click the Group Chat icon on the left navigation pane.

2. Enter your message in the IM input field at the bottom of the IM chat window, and click Enter.

You will receive IM message notifications with a red pop-out. Click the group chat window or 
participant’s name to view the message. 

Using Screen Sharing
You can use the screen sharing feature to present your screen to the conference participants. You can 
share the entire screen, a portion of the screen, or an application window. The area being shared is 
outlined by a green rectangular border.

Note
If the share icon is grayed out, your configuration might not support screen sharing. For more 
information, contact your Connect administrator.



Using Screen Sharing Managing Conferences 9

Connect Client User Guide 113

Figure 8 describes the various ways to share the screen.

Figure 8:  Screen Sharing Methods
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To share your screen with the conference participants:

1. On the Conference task bar, click .

2. To share the full screen, select Share Full Screen.

To share a portion of the screen, select Share Area.

To share an application window, select Share Window.

If you are a first-time user, select the appropriate option when you are prompted to install the 
presenter software.

3. If you are the conference host, screen sharing is enabled immediately after the connect presenter 
is installed.

If you are a participant, the screen sharing request is sent to the host. Connect client displays a 
notification on the conference task bar for all screen sharing requests. If the system notification for 
screen share is enabled, the Connect client also displays the system notification. Host must click 
Accept on the notification to view your screen, or click Reject.

To receive a system notification for screen sharing requests, refer to Managing System Notification 
for Screen Sharing Request on page 115.

After the host accepts your screen share invite, the screen share will start immediately.

During screen share, the tool bar with the following options is displayed at the top of the screen:

 Conference name
 Screen share status
 Pause sharing 
 End sharing 

To collapse or expand the tool bar, click the arrow next to the conference name.

4. Click  to pause screen sharing.

5. Click to stop sharing.

If another user starts to share the screen while you are sharing, your Connect presenter will exit and 
stop your screen sharing.

Note
When you attempt to share the screen in the Microsoft Edge browser for the first-time, the 
Connect client for Web displays multiple pop-ups to install the Connect Presenter.
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Managing System Notification for Screen Sharing Request

To disable the system notification for an incoming screen sharing request:

1. On the dashboard, click  or the <username> tab.

2. From the drop down, click Settings and then click Notifications.

3. Click Popup.

For Windows users:

4. Uncheck the Show a system notification for incoming Screen Share option.

For macOS users:

5. Click Configure via OS X Notification Center…".

6. In the Notifications center scroll down, and then click Mitel Connect.

7. Click None.

Using Video Conferencing
MiCloud Connect users can create video conferences for multiple participants from the Connect client. 

Creating a Video Conference
You can schedule a video conference by creating a new event in the Connect client. 

To create a video conference invite:

1. Click the Meetings tab on the dashboard.

2. Click  in the second pane.

3. In the New Event dialog, under Meeting Type, select Video Conference.

Note
By default, the system notification for screen sharing requests is enabled.

Note
Clicking None disables notifications for screen sharing, incoming calls and voicemails.

Note
This feature is available for US customers only.
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4. Click  to launch MiTeam Meeting.
The Miteam meeting’s Schedule a meeting panel opens.

5. Specify a Meeting title for the meeting.  

6. Click Calendar and from the drop-down list, choose the calendar to which you want to add the 
meeting invite.

7. In Search or enter Email address bar add participants for the meeting. You can add a maximum of 
100 participants with up to 16 video tiles.

a. To add a registered user, type the name of the user you are searching for. From the list, click 
the name to add the user as a participant to the meeting.

b. To add a guest user to a meeting, type the email address of the participant you want to add to 
the meeting.

8. Click Add to Calendar. The Scheduling proceeds based on the calendar type you selected from 
the Calendar drop-down list.

a. Default Calendar (.ics download) – downloads an ICS file with meeting join details, title, and 
participants. Open it in your default calendar app (such as Outlook desktop) and schedule the 
meeting.

b. Google Calendar – opens a new tab in Gmail with a prepopulated calendar invite with meeting 
join details, title, and participants.

c. Exchange / Office 365 – opens a new tab in Office 365 with a prepopulated calendar invite 
with meeting join details and title; but does not carry over the participants. You must add the 
participants directly in the open calendar in Office 365.

For more information, See MiTeam Meetings

Note
It is recommended to give a identifiable name that is easy to remember for the participants.

https://www.mitel.com/document-center/technology/cloudlink/all-releases/en/miteam-meetings-html
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Editing a Video Conference Invite

You can edit an existing video conference invite from Microsoft Outlook.

1. Click the Calender tab on the Shortcuts pane.

2. Open the video conference meeting invite. 

If you open an invite that is part of a recurring series in the Open Recurring Item dialog box, 
select Just this one, and then click OK.

3. Make the required changes in the Item Occurrence Window, and click Send Update.

When you edit the video conference invite in Microsoft Outlook, the video conference invite in the 
Connect client is automatically updated. 

To cancel a video conference, open the conference invite, click Meetings tab > Cancel Meeting and 
then click Send Cancellation in the Item Occurrence window.

Canceling a Video Conference 
If the meeting is no longer required, you can cancel a meeting from Microsoft Outlook. Canceling a 
meeting removes the invite from your Outlook calendar and sends a notification to all the meeting 
attendees.

To cancel from Microsoft Outlook, open the meeting invite and click Cancel Meeting.

Viewing Video Conferences
If you have integrated the Connect client with Microsoft Exchange, you can see your conferences in 
the Connect client.

1. In the Connect client, click the Meetings tab on the dashboard.

2. Click the Upcoming tab to view scheduled conferences or the Past tab to view past conferences. 

The list is sorted by date, from the most recent to oldest meetings. Video conferences display a 

 (MiTeam icon) next to the meeting description.

Joining a Video Conference

You can join a conference in the following ways:

 Joining a Video Conference from the Notification Area: You can join a conference from the 
notification area on the dashboard of the Connect client. The notification is usually sent five 
minutes prior to the conference. 
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 Joining a Video Conference from the Meetings Tab: You can join a conference before you receive 
a notification from the Connect client by clicking the Meetings tab.

 Joining a Video Conference from Outlook: You can join a conference from your Microsoft Outlook 
calendar.

Joining a Video Conference from the Notification Area

1. Click the event in the notification area, and then click the  icon next to the conference.

2. Enter the required details, and then click Enter now.

You can mute the audio and disable the video during the call.

3. Click the red Leave icon to end the video conference.

Joining a Video Conference from the Meetings Tab
1. Click the Meetings tab on the dashboard.

2. In the Upcoming Tab, click the  icon next to the conference you want to join.

3. Enter the required details, and then click Enter now.

You can mute the audio and disable the video during the call.

4. Click the red Leave icon to end the video conference.

Joining a Video Conference from Outlook
If you have successfully integrated the Connect client with Microsoft Exchange, you can join a 
conference by opening the meeting invite in your Outlook calendar.

1. Launch your Outlook calendar and open the conference appointment.

2. Click the link to Join the meeting. Enter the required details, and then click Enter now.

You can mute the audio and disable the video during the call.

3. Click the red Leave icon to end the video conference.

Sharing the Screen
You can share your screen with the video conference participants. While you are sharing, participants 
can view your entire computer screen and all your actions on the computer, until you stop the sharing.

Note
Guest (personal and external contacts) users will receive a meeting invite in their e-mail inbox. Click 
the join meeting link to join the meeting.
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To share the screen, click  and select the screen that you want to share. To end the screen sharing 

session, click .
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10. Sharing Screen

This chapter provides information about sharing screens.

Sharing Screens with a Contact..............................................................................  121
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Sharing Screens with a Contact
The Connect client enables easy sharing of screens with a contact.

1. Click the Contacts tab or enter the contact name/number in the Quick Dialer Search bar on the 
dashboard.

2. From the search results, select the contact.

3. On the Contact card to the left of the Avatar, click  to share your screen. 

4. Click:

 Share Full Screen: To share your entire computer screen with your contact. The information 
displayed on your screen is visible to your contact.

 Share Area: To share a movable rectangular area that you can use to share specific portions 
of your screen. 

 Share Window: To share any of the client application windows you have open on your 
computer. For example, you can choose to share only the Microsoft Outlook Email application 
window with your contact.

A screen sharing invite is sent to your contact as a notification. The contact must click  to 

accept viewing your screen, or click  to reject the screen sharing invite.

Optionally, if the contact card is open, click View Screen Share in the Actively Sharing... 
pop-up notification to accept the screen share.

5. After the contact accepts your screen sharing, the screen share will start immediately. The screen 
area being shared is highlighted with a green rectangular border.

To pause screen share, click . The rectangular border marking the area being shared 

becomes orange.

6. To call or have a conference with your contact, click  in the third pane (For information about 

using this feature, see Joining a Conference on page 103).

7. To end the screen sharing session, click the  at the top of the screen.

Note

 If you want to call your contact, before sharing your screen, see step 6.

 For MiCloud Connect users, the sharing of screen with a contact option is enabled only if 
the contact is on an audio call: otherwise, the sharing screen option does not appear for the 
contact.
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A notification is displayed in your contact’s third pane that indicates that you are no longer sharing 
your screen.

If your contact starts to share the screen while you are sharing, your Connect presenter will exit 
and stop your screen sharing.
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11. Managing Emergency Location
Information

This chapter describes how to add and manage the emergency location information in Connect Client 
softphone.

Emergency Location ...............................................................................................  125
RAY BAUM’S Act Overview ..............................................................................  125
Managing the Emergency Location Information ...............................................  125
FAQ ..................................................................................................................  128
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Emergency Location
The Emergency Location icon is introduced in Connect Client as part of the RAY BAUM Act and it is 
available only for US accounts.

RAY BAUM’S Act Overview
RAY BAUM’S Act is introduced in the US to ensure that proper and accurate dispatchable location 
information of the caller is conveyed when emergency 911 calls are made so that first responders can 
locate the caller quickly and accurately. The dispatchable location identifier is defined as the civic 
address of the calling party and includes information such as room number, floor number, or similar 
information that accurately identifies the location of the calling party. This can be floor-level information 
for multifloor installations and quadrant-level information for large buildings. When an emergency call 
is made, the location information can be provided directly by phones or, Multi-line Telephone Systems 
(MLTS) can provide location information based on the configuration.

As per the RAY BAUM’S Act, MLTS must provide the relevant Public Safety Answering Point (PSAP) 
along with the dispatchable location identifier conforming to the above definition for emergency 911 
calls for identifying the location of the calling party.

Managing the Emergency Location Information
As a Connect Client user, you can now add, edit, and verify your emergency location information in the 
Emergency Location page of Connect Client.

To manage the emergency location information, do the following:

1. On the Connect Client dashboard click . 

2. Click Settings, and then click Emergency Location.

The Emergency Location page opens.

Note
This feature is supported only for Connect Client in softphone mode; It is not supported for Connect 
Client in deskphone mode.

Notes
IMPORTANT: The RAY BAUM feature is not supported for Connect Client in virtual environments and 
for Connect Client installed on Windows 7, 32-bit operating systems. For unsupported environments, 
emergency calls (911) placed from Connect Client softphone are routed to the National E911 Call 
Center.
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3. To add the emergency location information:

a. In the Emergency Location page, click Add.

b. Complete the following fields:

 (Optional) Location Info: A description of the location.
 Street: The name of the street.
 City: The name of the city.
 Country: The name of the country.
 State/Province: The appropriate name of the state or the province.
 Zip/Postal Code: The zip code of the emergency location.

Note

 If you are setting the emergency location for the first time, you will be prompted to download 
and install Mitel Network Helper. To download and install Mitel Network Helper:

a. In the Emergency Location page, click Download.

The installation package downloads and the network helper icon appears 
on the desktop. 

b. Double-click the network helper icon and follow the instructions to install 
Mitel Network Helper.

For more information about the RAYBAUM feature, in the Emergency Location page, click 
Learn more next to Download.

IMPORTANT: 

 For installing Mitel Network Helper, you must have administrator rights. If you do not have 
administrator rights, contact your administrator.

 After installing Mitel Network Helper on Mac OS, you must restart the Connect Client 
application.

Note

 If Mitel Network Helper does not run on your system after the installation, the following 
error message displays in the Emergency Location page:

To resolve this issue, log out of Connect Client and log in again.
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c. Click Save.

The new location details are displayed in the Emergency Location page.

4. To edit the location information and make any updates:

a. In the Emergency Location page, click Edit and make the required updates.

b. Click Save and verify the updated details in the Emergency Location page.

Note
Connect Client suggests valid locations if there are minor errors in the location information 
entered. Select the suggested location, and then click Confirm.

Note
IMPORTANT: 

 The Emergency Location icon will appear as , and an error message that the emergency call 
location is required is displayed on the dashboard, as shown in Figure 9, in the following situations:

Figure 9:  Emergency Location

 If the location information is not added.
 If a network change is detected.
 If Mitel Network Helper is not running in your system.

Click either the Emergency Location icon or the Provide Now link in the error message to open the 
Emergency Location page and add/update the location information. For more information, see 
Managing the Emergency Location Information.



128 User Guide Connect Client

Managing Emergency Location Information FAQ11

FAQ
1. Why is the Connect Client installer not bundled with Mitel Network Helper? 

Ans: The Connect Client installer is not bundled with Mitel Network Helper due to the following 
reasons:

 An admin version and a non-admin version of Connect Client are available; however, 
there is no non-admin version for Mitel Network Helper. Bundling Mitel Network Helper 
with the Connect Client installer therefore leads to technical challenges for the non-admin 
installer version of Connect Client.

 When a new version of Mitel Network Helper is available, it can be downloaded and 
upgraded, independent of Connect Client.

 The Mitel Network Helper need not be upgraded as frequently as Connect Client, 
because Mitel Network Helper is installed only for Ray Baum.

Note

 The administrator of your account can configure the emergency location for all users in the account, 
which will be automatically picked up by Connect Client. You need not enter the emergency location 
if the location is pre-configured.

 You cannot delete the personal emergency locations configured by your administrator that are 
displayed in the Other Locations section. To delete the locations, contact your administrator.
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A.  Operator Features

This chapter provides information on how to enable, and access operator specific features.

Operator Features...................................................................................................  130
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Operator Features
Connect Operator license provides the operators with additional features and functionalities within the 
Connect client that makes easier to manage large volume of calls within the application.

Connect client provides special features for operators as listed in the Table 5

Table 5:  Operator Features Overview

Features Description

Drag and drop Operators can left-click and drag an 
object in both the directions; from 
call stack to a contact and vice 
versa.

Drag and hover Operators can left-click and hover 
an object in both the directions; from 
call stack to a contact and vice 
versa to access more telephony 
functions. The advanced telephony 
functions are:

 Blind Transfer
 Consultative Transfer
 Intercom Transfer
 Transfer to Mailbox
 Park
 Park and Page
 Park and Intercom
 Blind Conference
 Consultative Conference
 Intercom Conference
For more information, refer to 
Transferring a Call on page 55.

Call stack orientation Operators can view the oldest call at 
the top of the call stack and the 
most recent call at the bottom.

Double click to answer To answer an incoming call, 
operators can:

 Double-click anywhere in the 
incoming call notification area.

 Click the green call icon as other 
users.
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Routing slip Operators can view or hide the 
routing slip for each call by toggling 
the routing slip icon in the incoming 
call notification area.

Note: Routing slip is disabled by 
default.

To enable routing slip, refer to 
Managing Call Notes and Viewing 
Routing Slips on page 63.

Changing availability state of a 
contact

Operators can change a contact’s 
availability state if:

 Contact belongs to the contact 
group created by operator.

 Contact has added operator on 
his access list. To add a contact 
to access list, refer Allowing a 
Contact to Manage your 
Availability State on page 41.

To change a contact’s availability 
state, do one of the following:

 Right-click a contact, and select 
Change Availability <availability 
state>.

 Open the contact card by 
selecting a contact, click on the 
arrow next to contact’s availability 
state, and select the state.

Identifying the call by workgroup 
name

When an operator receives a call for 
a workgroup, the call notification on 
the dashboard displays the name of 
the workgroup. This helps users 
who are members of multiple 
workgroups to identify which 
workgroup is receiving a call.

Table 5:  Operator Features Overview

Features Description
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